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1Getting Started

In this section:

• Starting and Stopping the Server . . . . . . . . . . . . . . . . . . . .8
• Installing the Client Tools . . . . . . . . . . . . . . . . . . . . . . . . . .8
• Starting the Client Tools . . . . . . . . . . . . . . . . . . . . . . . . . . . .9
• A First Look at Management Console . . . . . . . . . . . . . . . . .9
• Configuring a New System . . . . . . . . . . . . . . . . . . . . . . . .11



Starting and Stopping the Server
You may need to stop and start the Spectrum™ Technology Platform server to perform maintenance
such as installing a lookup table or applying a product update.

• On Windows, Spectrum™ Technology Platform is set to start automatically when Windows starts up.
To ensure that Spectrum™ Technology Platform has started, right click on the Spectrum™ Technology
Platform icon in the Windows system tray. The Start Server menu item should be grayed out. To stop
Spectrum™ Technology Platform, select Stop Server

• To start or stop the server on Unix or Linux:
a) Change the working directory to the bin directory of where Spectrum™ Technology Platform is

installed. For example,
cd /usr/g1/tst/server/bin

b) Source the setup file. For example,
. ./setup

c) Launch Spectrum™ Technology Platform.

• To launch Spectrum™ Technology Platform in the background, type the following command:

./server.start

• To launch Spectrum™ Technology Platform in the foreground, type the following command:

./server.start console

To stop Spectrum™ Technology Platform, type the following command: ./server.stopNote:

Installing the Client Tools
The Spectrum™ Technology Platform client tools are Windows applications that you use to administer
your server and design and run dataflows and process flows. Youmust install your Spectrum™ Technology
Platform server before installing the client tools.

Before installing, be sure to read the release notes. The release notes contains important compatibility
information as well as release-specific installation notes.

This procedure describes how to install the following client tools:

• Enterprise Designer— Use Enterprise Designer to create, modify, and run dataflows.
• Management Console—Use theManagement Console to perform administrative tasks such as setting
service defaults, scheduling jobs, managing users and security, and so on.

• Interactive Driver—Use Interactive Driver to test different processing settings. Interactive Driver allows
you to run a small number of records through a process to preview the result.

• Job Executor—Job Executor is a command line tool that allows you to run a job from a command
line or script. The job must have been previously created and saved on Spectrum™ Technology
Platform using Enterprise Designer.

• Process Flow Executor—Process Flow Executor is a command line tool that allows the execution
of a process flow from a command line or script. The process flow must have been previously created
and saved on Spectrum™ Technology Platform using Enterprise Designer.

To install the client tools:

1. Open a web browser and go to the Spectrum™ Technology Platform Welcome Page at:

http://<servername>:<port>
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For example, if you installed Spectrum™ Technology Platform on a computer named
"myspectrumplatform" and it is using the default HTTP port 8080, you would go to:

http://myspectrumplatform:8080

2. Click Platform Client Tools.

Starting the Client Tools
The client tools (Enterprise Designer, Management Console, or Interactive Driver) are Windows
applications that you launch from the Start menu. They are easy to launch but there are a few things to
keep in mind.

To start a Spectrum™ Technology Platform client:

1. Select Start > Programs > Pitney Bowes > Spectrum™ Technology Platform > Client Tools.
2. Select the client you wish to start (Management Console, Enterprise Designer, or Interactive Driver).
3. Type in the server name or select it from the drop-down list.

If you have multiple instances of the Management Console accessing the same Spectrum™

Technology Platform server, it is possible for one user to overwrite another user's changes.
Note:

Therefore, it is recommended that you do not run multiple instances of the Management
Console against the same server.

4. Enter your user name and password.
5. In the Port field, enter the network port that the server has been configured to use for Spectrum™

Technology Platform communication. The default port number is 8080.
6. Click Use secure connection if you want communication between the client and the server to take

place over an HTTPS connection.

A secure connection is only available if HTTPS communication has been configured on the
server.

Note:

7. Click Login.

A First Look at Management Console
Management Console is the tool for administering your Spectrum™ Technology Platform system. This
topic provides an overview of the Management Console.

Using Management Console, you can perform such tasks as:

• Manage users and other security options
• Define connections to data sources such as databases or web services
• Specify default settings for services
• Schedule job execution

The figure below shows Management Console.
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Figure 1: Management Console

The nodes in the left pane provide access to the Management Console functions. The nodes are:

This node lists the modules you have installed on your system that have services
or administrative tools. Note that not all modules appear in Management Console

Modules

because some modules do not come with services or administrative tools. For
modules that come with predefined services, you can set the default processing
options for the services here. You can also define the reference databases to use
with the module, such as postal reference data or geocoding reference data, if
applicable.

This node contains options that control the running of dataflows and services,
including the scheduling of batch jobs, job logs, and data type conversion options.

Execution

This node contains options for defining connections to the data that you want to
process through Spectrum™ Technology Platform. In order for a dataflow designer

Resources

to be able to create a dataflow that either reads from or writes to a resource, you
must define that resource here.

This node contains options that can assist you in managing your system, including
email notification options, licensing information, and remote server configuration.

System

This node contains options for logging service errors, and also displays the event
log for the services on your system.

Event Log

This node contains the options for managing users.Security

This node contains options for usage reports.Transaction
History
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Configuring a New System
When you first install Spectrum™ Technology Platform there area few things you should do first as an
administrator before you start using the system to ensure that your system has a basic level of security
as well as access to the data you want to process through Spectrum™ Technology Platform.

1. Change the password for the admin user.
a) SelectStart > Programs > Pitney Bowes > Spectrum™ Technology Platform >Client Tools >

Management Console.
b) Under the Security node, click Users.
c) Select admin then click Modify.
d) In the Password field, enter a new password. Enter it again in the Confirm password field.
e) Click OK.

2. Create users and roles as needed.

For more information, see Creating a User on page 15.

3. Specify which folders on the Spectrum™ Technology Platform server you want to allow users to
access.

For more information, see Limiting Server Directory Access on page 33.

4. Define database resources if applicable.

To determine if you need to define database resources, expand the Modules node then expand
each module. If there is a Tools node with a database resource icon under it, then you need to define
database resources for that module.

5. Define the databases, file servers, and other data sources that you want to access from Spectrum™

Technology Platform.
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2Managing Security

In this section:

• Security Model . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .14
• Users . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .15
• Roles . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .16
• Secured Entity Overrides . . . . . . . . . . . . . . . . . . . . . . . . . .21
• Security for the Location Intelligence Module . . . . . . . . .23
• Disabling User Security . . . . . . . . . . . . . . . . . . . . . . . . . . .33
• Limiting Server Directory Access . . . . . . . . . . . . . . . . . . .33
• Configuring HTTPS Communication . . . . . . . . . . . . . . . . .35



Security Model
Spectrum™ Technology Platform uses a role-based security model to control access to the system. The
following diagram illustrates the key concepts in the Spectrum™ Technology Platform security model:

A user is an account assigned to an individual person which the person uses to authenticate to Spectrum™

Technology Platform, either to one of the client tools such as Enterprise Designer or Management
Console, or when calling a service through the API.

A user has one or more roles assigned to it. A role is a collection of permissions that grant or deny access
to different parts of the system. Roles typically reflect the kinds of interactions that a particular type of
user has with the system. For example, you may have one role for dataflow designers which grants
access to create and modify dataflows, and another role for people who only need to process data
through existing dataflows.

A role grants permissions to secured entity types. A secured entity type is a category of items to which
you want to grant or deny access. For example, there is a secured entity type called "Dataflows" which
controls the default permissions for all dataflows on the system.

If you need to fine-tune access you can optionally specify secured entity overrides. A secured entity
override controls access to a specific secured entity on the system. For example, the secured entity type
"Dataflows" specifies the default permissions for all dataflows on the system, while each individual
dataflow is a secured entity. If you want to grant or deny access to a specific dataflow, you would specify
a secured entity override for the dataflow. You can specify secured entity overrides for a user, which
overrides the permissions granted to the user by the user's roles. You can also specify secured entity
overrides for roles, which applies the overrides to all users who have that role. You can only apply
overrides for roles and users that you create, not for predefined roles and users.

Related Links
Disabling User Security on page 33
Creating a User on page 15
Creating a Role on page 17
Creating a Secured Entity Override on page 22
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Users
Spectrum™ Technology Platform user accounts control the types of actions users can perform on the
system. User accounts are required to:

• Use Management Console, Enterprise Designer, or Interactive Driver
• Run jobs on a schedule
• Run jobs from the command line
• Access services through web services or the API

There is an administrative account called admin that comes with the system. This account has full
access. The initial password is "admin".

You should change the admin password immediately after installing Spectrum™ Technology
Platform to prevent unauthorized administrative access to your system.

Important:

In addition to these default accounts you can create as many user accounts as your business requires.

Related Links
Creating a Secured Entity Override on page 22

Creating a User
This procedure describes how to create a Spectrum™ Technology Platform user account and assign a
role to the account.

1. Open the Management Console.
2. Expand Security then click Users.
3. Click Add.

The New User window appears.

4. Leave the Enable user box checked if you want this user account to be available for use.
5. Enter the user name in the User name field.

User names can only contain ASCII characters.Note:

6. Enter the user's password in the Password field.
7. Reenter the user's password in the Confirm password field.
8. Enter the user's email address in the Email address field.
9. Enter a description of the user in the Description field.
10. Select the roles you want to give to this user.
11. Click OK.

Related Links
Security Model on page 14

Modifying a User
This procedure describes how to modify an existing Spectrum™ Technology Platform user account.

You can modify all user information except user name. If you need to change a user name, you
must first delete the user then create a user with the new user name.

Note:

1. Open the Management Console.
2. Expand Security then click Users.
3. Click Modify.
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The User Properties window appears.

4. Leave the Enable user box checked if you want this user account to be available for use.
5. Enter the user's password in the Password field.
6. Reenter the user's password in the Confirm password field.
7. Enter the user's email address in the Email address field.
8. Enter the description of the user in the Description field.
9. Select the roles you want to give to this user.
10. Click OK.

Disabling a User Account
You can disable a user account so that it cannot be used to gain access to Spectrum™ Technology
Platform.When a user account is disabled it cannot be used to access Management Console, Enterprise
Designer, or Interactive driver. In addition, any jobs that run on a schedule using a disabled user account
will not run. API calls that use a disabled user account will also not work.

The user account "admin" cannot be disabled.Note:

1. Open Management Console.
2. Expand Security then click Users.
3. Select the user account you want to disable and click Modify.
4. Clear the Enable user check box.

The user account is now disabled and cannot be used to gain access to Spectrum™ Technology Platform.

Deleting a User
This procedure describes how to permanently delete a Spectrum™ Technology Platform user account.

User accounts can also be disabled, which prevents the account from being used to access the
system without deleting the account.

Tip:

1. Open the Management Console.
2. Expand Security then click Users.
3. From the User Management screen, select the user you want to delete and click Delete.
4. Click Yes to delete or No to cancel.

The user account "admin" cannot be deleted.Note:

Roles
A role is a collection of permissions that grant or deny access to different parts of the system. Roles
typically reflect the kinds of interactions that a particular type of user has with the system. For example,
you may have one role for dataflow designers which grants access to create and modify dataflows, and
another role for people who only need to process data through existing dataflows.

The following roles are predefined:

This role has full access to all parts of the system.admin

This role is for users that create dataflows and process flows in Enterprise Designer.
It provides the ability to design and run dataflows.

designer
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This role is for users who need to process data through Spectrum™ Technology
Platform but does not need to create or modify dataflows. It allows the user to access
services through web services and the API, and to run batch jobs.

integrator

This role is available only when the Location Intelligence Module module is installed.
It provides full access to named resources for this module when using spatial services.

spatial-admin

(Additional access is required to manage spatial resources using Management
Console. See Security for the Location Intelligence Module on page 23 for more
information.)

This role is available only when the Location Intelligence Module module is installed.
It provides read-only access to named resources for this module when using spatial

spatial-user

services. (Additional access is required to view spatial resources using Management
Console. See Security for the Location Intelligence Module on page 23 for more
information.)

This is the default role. It provides no access to the system. Users who have this role
will only gain access to the system if you grant permission through secured entity
overrides.

user

To view the permissions granted to each of these roles, open Management Console, go to Security and
click Roles. Then select the role you want to view and click View.

You cannot modify the predefined roles. However, you can create new roles using the predefined
roles as a starting point.

Tip:

Related Links
Creating a Secured Entity Override on page 22

Creating a Role
A role is a collection of permissions that you assign to a user. If the predefined roles that come with
Spectrum™ Technology Platform do not fit your organization's needs, you can create your own roles.

1. In the Management Console, browse to Security then expand Roles.
2. Click Add.
3. In the Role field, enter the name you want to give to this role. The name can be anything you choose.
4. If you want to use one of the predefined roles as a starting point for your new role, check the Copy

from box then select the role that you want to use as a starting point. The predefined role's permissions
are selected for you.

5. Optional: Since the list of secured entity types can be long, you may want to display only a certain
group of secured entity types. This can be useful if you want to apply the same permissions to all
entities in a group. For example, if you want to remove the Modify permission from all database
resources, you could filter to show just the Database Resources group. To display and modify only
one group:
a) Check the Enable group filtering box.
b) Click the funnel icon in the header of the Group column and select the group you want to display.
c) Check or clear the box in the column header of the permission you want to apply.
d) To return to the full list of secured entity types, click the filter icon and select (All) then clear the

Enable group filtering box.

6. Select the permissions you want to grant for each entity type. The permissions are:

Allows the user to view entities contained by the entity type. For example, if you allow
the View permission for the JDBC Connection entity type, users with this role would
be able to view database connections in Management Console.

View

Allows the user to modify entities contained by the entity type. For example, if you
allow the Modify permission for the JDBC Connection entity type, users with this role
would be able to modify database connections in Management Console.

Modify

Allows the user to create entities that fall into this entity type's category. For example,
if you allow the Create permission for the JDBC Connection entity type, users with
this role would be able to create new database connections in Management Console.

Create
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Allows the user to delete entities contained by the entity type. For example, if you
allow the Delete permission for the JDBC Connection entity type, users with this role
would be able to delete database connections in Management Console.

Delete

Allows the user to initiate processing of jobs, services, and process flows. For example,
if you allow the Execute permission for the Job entity type, users with this role would

Execute

be able to run batch jobs. If you allow the Execute permission for the Service entity
type, users with this role would be able to access services running on Spectrum™

Technology Platform through the API or web services.

7. Click OK.

The role is now available to be assigned to a user.

You can delete a role that you create, but only after you unassign it from all user accounts.Note:

Related Links
Security Model on page 14

Secured Entity Types - Platform
An entity type is a category of items to which you want to grant or deny access. For example, there is
an entity type called "Dataflows" which controls permissions for all dataflows on the system. Platform
entity types apply to all Spectrum™ Technology Platform installations, as compared to module-specific
entity types that apply only if you have installed particular modules. The platform-level entity types are:

Controls access to all dataflow types (jobs, services, and subflows)
in Enterprise Designer.

Dataflows

Controls the ability in Enterprise Designer to make dataflows
available for execution.

Dataflows - Expose

Controls access to the Event Log node in Management Console.Event Log

Controls access to job schedule and file monitor configuration in
Management Console.

Execution - File Monitor and
Scheduling

Controls access to the Job Options node in Management Console.
All users have View access to job options. You cannot remove
View access.

Execution - Job Options

Controls access to the Report Options node in Management
Console. All users have View access to report options. You cannot
remove View access.

Execution - Report Options

Controls access to the Sort Performance node in Management
Console. All users have View access to sort performance options.
You cannot remove View access.

Execution - Sort Performance

Controls access to the Type Conversion node in Management
Console. All users have View access to type conversion options.
You cannot remove View access.

Execution - Type Conversion
Options

Controls access to job execution history in Enterprise Designer
and Management Console.

Execution History - Jobs

Controls access to process flow execution history in Management
Console and Enterprise Designer.

Execution History - Process
Flows

Controls the ability to execute jobs in Enterprise Designer,
Management Console, and job executor.

Jobs

Controls access to configure license expiration notification emails
in Management Console.

Notification - License Expiration
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Controls access to the email notification options in Management
Console.

Notification - SMTP Settings

Controls access to process flows in Enterprise Designer.Process Flows

Controls the ability in Enterprise Designer to make process flows
available for execution.

Process Flows - Expose

Controls access to the Remote Servers node in Management
Console.

Remote Server

Controls the ability to configure JDBC connections in Management
Console.

Resources - Database
Connections

Controls access tomanaging external web services in Management
Console.

Resources - External Web
Services

Controls the ability to configure file servers in Management
Console.

Resources - File Servers

Controls the ability to configure JDBC drivers in Management
Console.

Resources - JDBC Drivers

Controls the ability to enable or disable restrictions on server
directory resources in Management Console.

Resources - Restrict server
directory access

Controls the ability to configure server directory resources in
Management Console.

Resources - Server directory
paths

Controls access to the Security Options node in Management
Console.

Security - Options

Controls access to role configuration in Management Console.Security - Roles

Controls access to secured entity overrides in Management
Console.

Security - Secured Entity
Overrides

Controls access for managing user accounts in the Users node of
Management Console.

Security - Users

Controls the ability to execute services through the API and web
services.

Services

Controls whether exposed subflows are available as a stage in
dataflows in Enterprise Designer.

Stages

Controls access to the license information displayed inManagement
Console.

System - Licensing

Controls access to the Version Information node in Management
Console.

System - Version Information

Controls access to the Transaction History node in Management
Console.

Transaction History

Secured Entity Types - Advanced Matching Module
An entity type is a category of items to which you want to grant or deny access. The following entity
types control access to parts of the Advanced Matching Module.

Controls access to the match rules in the Interflow Match stage, Intraflow
Match stage, Transactional Match stage, and Match Rules Management
Tool in Enterprise Designer.

Match Rules Management

Controls access to search indexes inWrite to Search Index, Candidate
Finder, and the Search Index Management Tool in Enterprise Designer.

Search Index Management
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Secured Entity Types - Business Steward Module
An entity type is a category of items to which you want to grant or deny access. The following entity type
controls access to parts of the Business Steward Module.

Controls the ability to modify or delete exception records assigned to other users in the
Read Exceptions stage and the Exception Editor. Also controls the ability to review and

Exceptions

manage exception record activity in the Exception Manager and enables access to
Performance data in the Business Steward Portal.

Users with Modify permissions for the Business Steward Portal group must also have
Security-Users View permissions for the Platform group in order to assign or reassign
exception records.

Secured Entity Types - Data Hub Module
An entity type is a category of items to which you want to grant or deny access. The following entity
types control access to parts of the Data Hub Module.

Controls the ability to execute algorithms in the Relationship Analysis Client.Algorithms

Controls the ability for users to perform the following actions using Data Hub stages
and the Relationship Analysis Client:

Model Admin

• Read model data: entities, relationships, and their properties
• Create models and model data: entities, relationships, and their properties
• Modify model data: entities, relationships, and their properties
• Delete models and model data: entities, relationships, and their properties

For example, if you had amodel comprised of insurance data, youmight have doctors
and patients as entities, with relationships such as "visited" or "filed a claim for," and
properties that depict the dates for those visits or claims. Using this example, the
Model Admin entity type would allow you to grant permissions for the following actions:

• Read data for doctors and patients and their visit or claim properties
• Create doctor and patient entities, link them together with visit or claim relationships,
and include any properties such as addresses, claim IDs, dates, and so on.

• Modify doctor and patient entities, their relationships, and their properties such as
addresses, claim IDs, dates, and so on.

• Delete doctors and patients from the model

Controls the ability for users to perform the following actions using Data Hub stages
and the Relationship Analysis Client:

Model
Metadata

• Read entity types and relationship types
• Create entity types, relationship types, and their properties
• Modify entity type properties and relationship type properties
• Delete entities and relationships

This permission includes clearing a model in the Write to Hub stage.Note:

Controls the ability to create monitors in the Relationship Analysis Client that detect
changes to a model's entities or relationships.

Monitor Admin

Controls the ability to define themes for models in the Relationship Analysis Client.Theme Admin
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Secured Entity Types - Data Normalization Module
An entity type is a category of items to which you want to grant or deny access. The following entity
types control access to parts of the Data Normalization Module.

Controls access to the Advanced Transformer tables in the Table
Management tool in Enterprise Designer.

Advanced Transformer Tables

Controls access to cultures in the Open Parser Domain Editor tool
in Enterprise Designer.

Open Parser Cultures

Controls access to domains in the Open Parser Domain Editor tool
in Enterprise Designer.

Open Parser Domains

Controls access to the Open Parser tables in the Table Management
tool in Enterprise Designer.

Open Parser Tables

Controls access to the Standardization tables in the Table
Management tool in Enterprise Designer.

Standardization Tables

Secured Entity Types - Enterprise Data Integration Module
An entity type is a category of items to which you want to grant or deny access. The following entity
types control access to parts of the Enterprise Data Integration Module.

Controls access to caches used by the Write to Cache and Query Cache stages,
and the Cache Management tool in Management Console.

Cache

Secured Entity Types - Location Intelligence Module
An entity type is a category of items to which you want to grant or deny access. The Location Intelligence
Module has the following module-specific entity type:

Named Resources

Controls permissions to all named resources in the Location Intelligence Module, including named maps,
named tiles, named tables, and named connections. Users of Location Intelligence Module services
must have at least read permissions for the resources they use as well as for any dependent resources.

Secured Entity Types - Database Resources
An entity type is a category of items to which you want to grant or deny access. Database resources are
available depending on which modules you have installed, for example:

• Centrus Database Resources
• Enterprise Routing
• Spatial Database Resources

Secured Entity Overrides
A secured entity override controls access to a specific secured entity on the system. For example, the
secured entity type "Dataflows" specifies the default permissions for all dataflows on the system, while
each individual dataflow is a secured entity. If you want to grant or deny access to a specific dataflow,
you would specify a secured entity override for the dataflow. You can specify secured entity overrides
for a user, which overrides the permissions granted to the user by the user's roles. You can also specify
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secured entity overrides for roles, which applies the overrides to all users who have that role. You can
only apply overrides for roles and users that you create, not for predefined roles and users.

Creating a Secured Entity Override
A secured entity override specifies permissions for specific secured entities in the system, such as
specific dataflows or specific database connections. To create a secured entity override:

1. In Management Console, expand Security then click Secured Entity Overrides.
2. Do one of the following:

• If you want to specify a secured entity override for a role, click Role. The overrides you specify will
affect all users who have the role you choose.

• If you want to specify a secured entity override for a user, click User. The overrides you specify
will only affect the user you choose.

3. Click Browse to select the specific role or user then click OK.
4. Click Add then Browse.

The Select Secured Entity Type window appears.
5. Select the secured entity type that contains the secured entity you want to override then click OK.

For example, if you want to override a dataflow secured entity, choose Platform.Dataflows.

To select multiple secured entity overrides, use CTRL+click. To select a range of secured entity
overrides, use SHIFT+click.

Tip:

6. Choose the secured entity that you want to override. Click Add then Close.

The secured entities you chose are displayed. The secured entity type's row shows the permissions
in effect for the selected role or user. A gray checked box indicates that the permission is enabled
and a gray empty box indicates that the permission is disabled.

7. Specify the secured entity overrides you want. Each permission can have one of the following settings:

There is no override for the permission. The permission is the default permission granted
to the user or role.

The permission is denied to the user or role, overriding whatever permission is specified
in the secured entity type.

The permission is granted to the user or role, overriding whatever permission is specified
in the secured entity type.

Secured Entity Override Example

The following shows a secured entity override for the role
RetentionDepartmentDesigner.

In this example, the Platform.Dataflow secured entity type is set to allow the View and
Modify permissions but not the Delete permission. So by default, any user that has
the RetentionDepartmentDesigner role would have these permissions for all dataflows.
However, you want to prevent users with this role from modifying the
GeoConfidenceSurface dataflow only. So, you clear the checkbox in the Modify column
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for the GeoConfidenceSurface secured entity. Now users with this role will not be able
to modify this dataflow but will still be able to modify other dataflows.

You also want to make sure that users with this role always have the ability to modify
theGeocodeAddress dataflow even if the secured entity type's permissions are changed
at the role level. So, you place a check mark in the Modify column for GeocodeAddress,
replacing the block. Now, even if the Platform.Dataflow secured entity type is changed
to remove the Modify permission, users with this role will still be able to modify the
GeocodeAddress dataflow.

Related Links
Security Model on page 14
Security for the Location Intelligence Module on page 23

Users on page 15
Roles on page 16

Viewing a Secured Entity Override
A secured entity override specifies permissions for specific secured entities in the system, such as
specific dataflows or specific database connections. To view secured entity overrides for a role or user:

1. In Management Console, expand Security then click Secured Entity Overrides.
2. Do one of the following:

• If you want to view a secured entity override for a role, click Role.
• If you want to view a secured entity override for a user, click User.

3. Click Browse to select the specific role or user then click OK.

The secured entities with overrides for the role or user you chose are displayed.

The secured entity type's row (for example, Platform.Dataflows) shows the permissions in effect for
the selected role or user. A gray checked box indicates that the permission is enabled and a gray
empty box indicates that the permission is disabled.

The secured entity rows (for example, the specific dataflow GeocodeAddress) shows the permissions
in effect for that entity, each of which can have one of the following settings:

There is no override for the permission. The permission is the default permission granted
to the user or role.

The permission is denied to the user or role, overriding whatever permission is specified
in the secured entity type.

The permission is granted to the user or role, overriding whatever permission is specified
in the secured entity type.

Security for the Location Intelligence Module
The Location Intelligence Module uses the same role-based security that is used for the Spectrum™

Technology Platform. Because security is handled at the platform level, the Management Console can
be used to manage all Location Intelligence Module security activities. This includes setting permissions
for named resources in addition to managing user accounts (that is, creating, modifying, and deleting
user accounts).

The User Management Service can still be used to set permissions if desired; however,
permissions are stored in the platform and not the repository, and cannot be set at the folder or
directory level. The User Management Service is set to be deprecated in the next release.

Note:
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After you install the Location Intelligence Module, two predefined roles are available in Management
Console, spatial-admin and spatial-user.

The spatial-admin role provides full permissions (View/Modify/Create/Delete) for all named resources
(named maps, named tiles, named connections, and named tables), whereas the spatial-user role
provides only View permissions to these resources. These permissions are controlled using the Location
Intelligence Module's secured entity type, Location Intelligence.Named Resources. Users of Location
Intelligence Module services must have at least View permissions for the resources they use as well as
for any dependent resources.

These predefined spatial roles, when assigned to a user, provide access to named resources only when
using spatial services. They do not allow access to named resources in Management Console. The
"admin" user in Spectrum has full access to manage all parts of the system, including named resources,
via the Management Console. If you also want users who can access only named resources via the
Management Console, you must manually create a "named resources administrator" role, using one of
the predefined spatial roles as a base, that provides access to named resources in the repository then
assign that role to a "named resources administrator" user account. For instructions on creating this
additional resource-administrator role, see Creating a Named Resources Administrator on page 30.
Dataflow designers who require access to named resources also need additional permissions beyond
that of the "designer" role. For instructions on creating a spatial dataflow designer, seeCreating a Spatial
Dataflow Designer on page 31.

Roles and associated permissions on the Location Intelligence.Named Resources secured entity type
can all be viewed using Management Console.

• Predefined roles, which are not editable:

• Permissions for spatial-admin, on the Location Intelligence.Named Resources secured entity:

• Permissions for spatial-user, on the Location Intelligence.Named Resources secured entity:
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The permission settings in the User Management Service are mapped to the Spectrum™

Technology Platform as follows: Read>View, Modify>Modify, Add>Create, and Remove>Delete.
Note:

You can create custom roles based on the predefined spatial roles, assign them to user accounts, then
fine-tune access to named resources for those roles and users by applying secured entity overrides to
individual named resources. Overrides cannot be applied to folders or directories, so anytime a named
resource is added you must specify any necessary overrides for that resource.

Related Links
Creating a Secured Entity Override on page 22

Example: Overriding Permissions at the Role Level
A typical scenario and best practice for setting security for the Location Intelligence Module involves
creating a custom role with no permissions, applying specific overrides to the custom role, then assigning
that role to a user.

In this example, you will:

1. Create a custom role with no permissions.
2. Apply overrides to the custom role allowing modify and delete permissions for named tables in the

repository.
3. Create a user account and assign the custom role along with a pre-defined spatial role to it.

Step 1. Creating a Custom Role
If the predefined roles that come with Spectrum™ Technology Platform do not fit your organization's
needs, you can create your own roles. In this example, you will create a custom role called table-modifier
that initially has no permissions.

Before you begin, verify that security is enabled, see Disabling User Security on page 33.Note:

1. In the Management Console, browse to Security then click Roles.
2. Click Add.

The Add Role dialog appears.

3. In the Name field, enter the name you want to give to this role, table-modifier.
No permissions are set for this role.
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4. Click OK.

The role is now available to be assigned overrides.

Step 2. Applying Overrides to a Role
A secured entity override grants permissions for specific secured entities in the system, such as named
tables that are in the repository. In this step of the example, you will create an override for the
table-modifier role that allows modifying and deleting of named tables:

1. In Management Console, expand Security then click Secured Entity Overrides.
2. Click Role then Browse.

The Select Role dialog appears.

3. Select the table-modifier role and click OK.
4. Click Add.

The Select Items dialog appears.
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5. Click Browse.
The Select Secured Entity Type window appears.

6. Select the Location Intelligence.Named Resources secured entity type. Click OK.
A list of all secured entities that are named resources appears.

7. From the list of secured entities, locate then select all the named table resources (use the Shift key
to select multiple consecutive items in this dialog).

Overrides can be applied only to individual named resources, not to folders or directories.Note:

8. Click Add then Close.

The secured entities (named tables) you chose are displayed. The secured entity type's row shows
the permissions in effect for the table-modifier role. A gray checked box indicates that the permission
is enabled and a gray empty box indicates that the permission is disabled.

9. Specify overrides on each secured entity (named table) by selecting all checkboxes in the Modify
and Delete columns:

10. Click Save or select File > Save.

The asterisk next to the "Secured Entity Overrides" window title no longer appears, indicating that
the changes are saved.

The table-modifier role now permits modifying and deleting of named tables, and can be assigned to a
user account.

If named tables are subsequently added to the repository, you will need to add security entity
overrides for each of those named tables.

Note:

Step 3. Creating a User
In the final step of this example, you will create a user account to which you will assign both the pre-defined
spatial-user role (which provides view-only permissions to named resources) as well as the custom
table-modifier role (which grants additional permissions for modifying and deleting named tables).

1. In Management Console, expand Security then click Users.
2. Click Add.

The New User window appears.
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3. Leave the Enable user box checked if you want this user account to be available for use.
4. Enter the user name (user-tables) in the User name field.
5. Enter the user's password in the Password field.
6. Re-enter the user's password in the Confirm password field.
7. Enter the user's email address in the Email address field.
8. Enter a description of the user in the Description field.
9. Select the spatial-user and table-modifier roles.

10. Click OK.

A user-tables user account is now available with view-only permissions to all named resources as well
as modify and delete permissions for named tables.

Example: Overriding Permissions at the User Level
Another scenario for setting security for the Location Intelligence Module involves establishing override
permissions for a single user.

In this example, you will:

1. Create a user with view-only permissions to named resources.
2. Apply overrides to the user account that allow modifying and deleting of a specific named tile.

Step 1. Creating a User with View Permissions
First, you will create a user account to which you will assign the pre-defined spatial-user role. This role
provides view-only permissions to named resources.

1. In Management Console, expand Security then click Users.
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2. Click Add.

The New User window appears.

3. Leave the Enable user box checked if you want this user account to be available for use.
4. Enter the user name (user-tiles) in the User name field.
5. Enter the user's password in the Password field.
6. Re-enter the user's password in the Confirm password field.
7. Enter the user's email address in the Email address field.
8. Enter a description of the user in the Description field.
9. Select the spatial-user role.

10. Click OK.

A user-tiles user account is now available with view-only permissions to all named resources.

Step 2. Applying Overrides to a User
A secured entity override grants permissions for specific secured entities in the system. In the final step
of this example, you will create an override that allows a single user (user-tiles) to modify and delete a
specific named tile in addition to being able to view all types of named resources:

1. In Management Console, expand Security then click Secured Entity Overrides.
2. Click User then Browse.

The Select User dialog appears.

3. Select the user (user-tiles) and click OK.
4. Click Add.

The Select Items dialog appears.
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5. Click Browse.
The Select Secured Entity Type window appears.

6. Select the Location Intelligence.Named Resources secured entity type. Click OK.
A list of all secured entities that are named resources appears.

7. From the list of secured entities, locate then select /Samples/NamedTiles/USATile.
8. Click Add then Close.

The secured entity (named tile) you chose is displayed. The secured entity type's row shows the
permissions in effect for the user-tiles user. A gray checked box indicates that the permission is
enabled and a gray empty box indicates that the permission is disabled.

9. Specify overrides on the secured entity (named tile) by selecting the checkboxes in the Modify and
Delete columns:

10. Click Save or select File > Save.

The asterisk next to the "Secured Entity Overrides" window title no longer appears, indicating that
the changes are saved.

The user-tiles user can now modify, delete, and view a specific named tile
(/Samples/NamedTiles/USATile), but can only view all other named tiles and named resources.

Creating a Named Resources Administrator
To view or manage named resources in the repository using Management Console, a user must have
an assigned role that allows full access to those resources in addition to the access that is provided by
the predefined spatial roles. The predefined spatial roles cannot be modified and a predefined "Named
Resources Administrator" role is not provided by the Spectrum™ Technology Platform; however, you
can create such a role using a predefined spatial role as a base.

1. In the Management Console, browse to Security then click Roles.
2. Click Add.
3. In the Name field, enter the name you want to give to this role (for example, "resource-admin").
4. Check theCopy from box then select either the spatial-admin or spatial-user role to use as a starting

point. The spatial-admin role provides View, Modify, Create, and Delete permissions for the Location
Intelligence Module.Named Resources secured entity type; the spatial-user role provides View
permissions.

5. Set additional permissions as follows for these secured entity types:

Database Resources:

• Centrus Database Resources to View/Modify/Create/Delete/Execute (if required)
• Enterprise Routing to View/Modify/Create/Delete/Execute (if required)
• Spatial Database Resources to View/Modify/Create/Delete/Execute for a spatial-admin, or to
View/Execute for a spatial-user

Platform:

• Resources - File Servers to View
• Resources - JDBC Drivers to View
• Services to View/Modify/Execute
• System - Version Information to View
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6. Click OK to save the new resource-admin role.
7. Under Security, click Users.
8. Either select an existing user and click Modify, or click Add to create a new user.
9. Assign the new "resource-admin" role to the user account to allow it to manage and/or view named

resources in Management Console.

The user now has the access required to view and/or manage named resources in Management Console.

Creating a Spatial Dataflow Designer
To create dataflows for Location Intelligence Module stages and services, a user must have both the
designer and spatial-user roles assigned. The spatial-user role provides View access to named resources
under the Location Intelligence.Named Resources secured entity type. The designer role provides the
necessary access to Platform secured entity types such as Dataflows.

1. In the Management Console, browse to Security then click Users.
2. Either select an existing user and click Modify, or click Add to create a new user.
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3. Assign both the designer and spatial-user roles to the user account.

The user now has permission to view named resources and design dataflows using those resources for
Location Intelligence Module stages and services.

Turning off Security for Services and the Repository
All services and access to resources used by the Spectrum™ Technology Platform Location Intelligence
Module are configured, by default, with authentication turned on. This allows certain functionality to
restrict access to resources and the ability to modify resources in the repository. For example, the Named
Resource Service AddNamedResource operation, and the CSW service Harvest operation both require
authentication, as both of these operations require write permissions to the repository.

The service-level authentication can be turned off for all services and the repository. This is useful if you
have your own high-level authentication built into the solution that is using the Location Intelligence
Module services.

To turn off service and repository security, use the JMX console.

1. Access the JMX Console using the following URL: http://localhost:8080/jmx-console/ (replacing
localhost and port 8080 with your correct configuration).

2. Under the Domain: com.pb.spectrum.platform.config section, select the administration
link for the WebServiceSecurityConfigurationManager.

3. For RestServiceSecurityType and SoapServiceSecurityType enter OPEN in the value
field and click set for each.

4. Restart the server.

Once finished, security is turned off for the services and repository.

Related Links
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Disabling Platform Security Versus Turning Off Spatial Security on page 33

Disabling Platform Security Versus Turning Off Spatial Security
The Spectrum™ Technology Platform allows you to disable role-based security at the platform level and
service-level security as two separate operations.

Disabling role-based security at the platform level (by deselecting ‘Limit access according to user
permissions’ on the Security > Options node in Management Console) means that the permissions
assigned to users (via roles and secured entity overrides) will not be enforced and all users will be able
to access all parts of the system. The Location Intelligence Module will then allow access to any named
resource in the repository.

Turning off service-level security on the JMX Console (by setting RestServiceSecurityType and
SoapServiceSecurityType to OPEN) causes the execution of service requests to use the admin
user. For the Location Intelligence Module this means that any named resource that is added to the
repository is “owned” by the admin user; therefore, running the User Management Service’s
getPermissions request will show that non-admin users have only "Read" permissions.

Disabling both service-level and role-based security completely opens up the Location Intelligence
Module's services and named resources. Running the User Management Service’s getPermissions
request will also show that non-admin users now have "All" permissions

Related Links
Disabling User Security on page 33
Turning off Security for Services and the Repository on page 32

Disabling User Security
User security is enabled by default. This means that the security restrictions assigned to users through
roles are enforced. If you want to disable user security, the security restrictions assigned to users will
not be enforced and all users will be able to access all parts of the system. Note that a valid user account
is always required to access services even if you disable user security.

This procedure describes how to disable user security.

If you follow this procedure all users will have full access to your Spectrum™ Technology
Platform system.

Warning:

1. Open the Management Console.
2. Expand Security then click Options.
3. Clear the Limit access according to user permissions check box.

Related Links
Security Model on page 14
Disabling Platform Security Versus Turning Off Spatial Security on page 33

Limiting Server Directory Access
Enterprise Designer and Management Console users have the ability to browse the Spectrum™

Technology Platform server's folders and files, such as when selecting an input or output file when
configuring a source or sink stage in a dataflow, or defining a database resource. You may want to restrict
file browsing so that sensitive portions of the server are kept off limits. You can prevent all browsing or
you can specify the folders that you want users to be able to browse. The folders you specify appear as
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the top-level folders in users' file browse windows. For example, if you allow users to only access a folder
on the server named WestRegionCustomers, when users browse the server they would only see that
folder, as shown here:

To restrict access to the server's file system, follow this procedure.

1. Open Management Console.
2. Under Resources, select Server Directory Access.
3. Do one of the following:

• To prevent users from browsing the server entirely, check the box Restrict server directory
access and do not perform any of the following steps. Users will have no access to any of the files
or folders on the server.

• To allow access to some folders on the server, proceed to the following step.

4. Click Add.
5. In the Name field, give a meaningful name for the folder to which you are granting access.
6. In the Path field, specify the folder to which you want to grant access.

Users will be able to access all subfolders contained in the folder you specify.Note:

7. Click OK.
8. If you want to grant access to additional folders, repeat the previous steps as needed.
9. Enforce the restrictions by checking the Restrict server directory access box.

Users will now only have access to the folders you have specified.

If there are any dataflows that had previously accessed files that are no longer available because
of file browsing restrictions, those dataflows will fail.

Note:
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Configuring HTTPS Communication
By default, Spectrum™ Technology Platform communication with the client tools (Enterprise Designer,
Management Console, and Interactive Driver) and API occurs over HTTP. You can configure Spectrum™

Technology Platform to use HTTPS if you want to secure these network communications.

1. Stop the Spectrum™ Technology Platform server.

• To stop the server onWindows, right-click the Spectrum™ Technology Platform icon in theWindows
system tray and select Stop Server. Alternatively, you can use theWindows Services control panel
and stop the Pitney Bowes Spectrum™ Technology Platform service.

• To stop the server on Unix or Linux, source the <SpectrumLocation>/server/bin/setup
script then execute the <SpectrumLocation>/server/bin/server.stop script.

2. Create a certificate and load it into a JSSE keystore. For more information, see
http://docs.codehaus.org/display/JETTY/How+to+configure+SSL.

3. Create an XML file named spectrum-override-container-ssl.xml containing the following:

<beans xmlns="http://www.springframework.org/schema/beans"
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xmlns:util="http://www.springframework.org/schema/util"
xsi:schemaLocation="http://www.springframework.org/schema/beans

http://www.springframework.org/schema/beans/spring-beans-3.0.xsd
http://www.springframework.org/schema/util

http://www.springframework.org/schema/util/spring-util-3.0.xsd">

<bean id="defaultWebServerConnector"
class="com.g1.dcg.server.jetty.JettyDelayedServerConnector">

<constructor-arg ref="webServer"/>
<constructor-arg>

<bean class="org.eclipse.jetty.util.ssl.SslContextFactory">
<property name="keyStorePath" value="/SpectrumKeystore"/>

<property name="keyManagerPassword" value="password"/>
<property name="keyStorePassword" value="password"/>

</bean>
</constructor-arg>
<property name="host" value="${spectrum.bind.address}"/>
<property name="port" value="${spectrum.http.port}"/>
<property name="idleTimeout" value="-1"/>

</bean>
</beans>

4. Modify the following lines as needed to reflect your environment:

Modify the value to be the relative path from
<ServerLocation>/server/app/conf/spring

<property name="keyStorePath"
value="/SpectrumKeystore"/>

to the keystore you are using. This example
assumes the keystore in the root of the drive on
which the Spectrum™ Technology Platform server
is installed.

Modify the value to be the password to the
keystore.

<property name="keyManagerpassword"
value="password"/>

Modify the value to be the password to the key
within the keystore.

<property name="keyStorePassword"
value="password"/>

5. Save the spectrum-override-ssl.xml file to
<SpectrumLocation>/server/app/conf/spring.

6. Using a text editor, open the file spectrum-container.properties located in
<SpectrumLocation>/server/app/conf and set the following properties:
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spectrum.http.port=8443
spectrum.runtime.hostname=dnsname
Where dnsname is the external DNS for the server.

7. Start the Spectrum™ Technology Platform server.

• To start the server onWindows, right-click the Spectrum™ Technology Platform icon in theWindows
system tray and select Start Server. Alternatively, you can use the Windows Services control
panel to start the Pitney Bowes Spectrum™ Technology Platform service.

• To start the server on Unix or Linux, execute the
<SpectrumInstallDirectory>/server/bin/server.start script.
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Introduction to Database Resources
Somemodules rely on reference data to perform their processing. For example, the Universal Addressing
Module uses databases containing postal data from postal authorities such as the United States Postal
Service® to validate addresses. The Database Resources tool allows you to manage these databases.

Adding a Database Resource

Adding an Enterprise Geocoding Module Global Database Resource
Unlike other stages, the Geocode Address Global and Reverse Geocode Global stages are not visible
in Management Console, Enterprise Designer, or Interactive Driver until you define a database resource.
New stages are created for each global database resource that you define. For example, if you define
one database resource containing databases for Mexico and Canada, and another database resource
containing data for Australia and Singapore, you would see two Geocode Address Global stages, one
capable of geocoding addresses in Mexico and Canada and the other capable of geocoding addresses
in Australia and Singapore. You would also see two Reverse Geocode Global stages, one for Mexico
and Canada and one for Australia and Singapore.

Note: • Australia, Canada, France, Germany, and Japan have large geocoding databases. Do not put
more than one or two of these in the same database resource.

• If you are running the Spectrum™ Technology Platform server on a 64-bit machine, database
resources should contain no more than eight to ten countries. If you require more, Java memory
settings need to be modified. For assistance, contact technical support.

To create a Geocode Address Global database resource:

1. If you haven't already done so, install the database files on your system. For instructions on installing
databases, see the Spectrum™ Technology Platform Installation Guide.

2. In Management Console, expand Modules > Enterprise Geocoding > Tools then click Global
Database Resources.

3. ClickAdd to create a new database resource or clickModify to change an existing database resource.
4. In the Name field, specify the name you want to give to this resource. This name can be anything

you choose. You typically create a new database resource each time you receive an updated
geocoding database from Pitney Bowes Software so you may want to consider using the database
date in the database resource name.

5. Click Add.
6. Click Add again.
7. In the Name field, specify a name for this database path. This name can be anything you choose.
8. In the Path field specify the folder that contains the database files for the country you selected. The

database files are typically found in:
<InstallLocation>\IGEO-<CountryCode>\<Version>\datawhere <InstallLocation> is the
directory you specified when you installed the database files, <CountryCode> is the two-letter country
code, and <Version> is the version number of the data. Some countries may havemultiple databases
in the data directory, some of which youmay have licensed and some youmay have not. Only specify
the location of the data you have licensed.

Do not put databases on a network drive. Doing so can cause performance problems.Note:

9. If the database is a custom database, check the Custom database box. A custom database is a
user-defined database that contains addresses and latitude/longitude coordinates that you can use
for geocoding.
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If you are specifying a path for a custom database you must specify a path to a Pitney Bowes
Software provided database first. The first path in all database resources must be a path for
a Pitney Bowes Software provided database.

Note:

10. Click OK.
11. If you have additional database paths to add, click Add, otherwise click OK.
12. If you have additional countries to add, click Add, otherwise click OK. By adding multiple countries

to the same database resource, you will create a Geocode Address Global stage that can geocode
addresses for each country in one stage.

13. In the Pool size field, specify the maximum number of concurrent requests you want this database
to handle.

The optimal pool size varies by module. You will generally see the best results by setting the pool
size between one-half to twice the number of CPUs on the server, with the optimal pool size for most
modules being the same as the number of CPUs. For example, if your server has four CPUs you
may want to experiment with a pool size between 2 (one-half the number of CPUs) and 8 (twice the
number of CPUs) with the optimal size possibly being 4 (the number of CPUs).

When modifying the pool size you must also consider the number of runtime instances specified in
the dataflow for the stages accessing the database resource. Consider for example a dataflow that
has a Geocode US Address stage that is configured to use one runtime instance. If you set the pool
size for the US geocoding database to four, you will not see a performance improvement because
there would be only one runtime instance and therefore there would only be one request at a time
to the database resource. However, if you were to increase the number of runtime instances of
Geocode US Address to four, you might then see an improvement in performance since there would
be four instances of Geocode US Address accessing the database resource simultaneously, therefore
using the full pool.

You should conduct performance tests with various settings to identify the optimal pool size
and runtime instance settings for your environment.

Tip:

14. If there are any open Enterprise Designer sessions, click the refresh button to see the new stage.

Adding an Enterprise Geocoding Module U.S. Database Resource
Whenever you install a new database resource or modify an existing database resource you must define
it in the Management Console in order for it to become available on your system. This procedure describes
how to add or modify a U.S.database resource for the Enterprise Geocoding Module. For instructions
on database resources for geocoding non-U.S. locations, seeAdding an Enterprise Geocoding Module
AUS or GBR Database Resource on page 40.

1. If you haven't already done so, install the database files on your system. For instructions on installing
databases, see the Spectrum™ Technology Platform Installation Guide.

2. In Management Console, expand Modules > Enterprise Geocoding > Tools > US Database
Resources.

3. Click Add to install a new database or click Modify to change an existing database resource.
4. If you are adding a new database, enter a name for the database resource in the Name field. The

name can be anything you choose. You cannot modify the name of an existing database resource.
Changing the name of an existing database resource would cause any services or jobs that reference
the database resource to fail.

If you are using the Enterprise Geocoding Module with the Siebel Module, name the U.S.
geocoding database KGDDatasource.

Note:

5. In the Path elements field, specify the folder that contains the database files. You can include multiple
database paths. This allows you to specify a single resource that includes both the primary database
and any optional databases you may have, such as DPV, LACSLink, or elevation data.

6. In the Pool size field, specify the maximum number of concurrent requests you want this database
to handle.

The optimal pool size varies by module. You will generally see the best results by setting the pool
size between one-half to twice the number of CPUs on the server, with the optimal pool size for most
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modules being the same as the number of CPUs. For example, if your server has four CPUs you
may want to experiment with a pool size between 2 (one-half the number of CPUs) and 8 (twice the
number of CPUs) with the optimal size possibly being 4 (the number of CPUs).

When modifying the pool size you must also consider the number of runtime instances specified in
the dataflow for the stages accessing the database resource. Consider for example a dataflow that
has a Geocode US Address stage that is configured to use one runtime instance. If you set the pool
size for the US geocoding database to four, you will not see a performance improvement because
there would be only one runtime instance and therefore there would only be one request at a time
to the database resource. However, if you were to increase the number of runtime instances of
Geocode US Address to four, you might then see an improvement in performance since there would
be four instances of Geocode US Address accessing the database resource simultaneously, therefore
using the full pool.

You should conduct performance tests with various settings to identify the optimal pool size
and runtime instance settings for your environment.

Tip:

7. Click OK.

Adding an Enterprise Geocoding Module AUS or GBR Database Resource
Whenever you install a new database resource or modify an existing database resource you must define
it in the Management Console in order for it to become available on your system. This procedure describes
how to add or modify a database resource for the Enterprise Geocoding Module for Australia or Great
Britain.

1. If you haven't already done so, install the database files on your system. For instructions on installing
databases, see the Spectrum™ Technology Platform Installation Guide.

2. In Management Console, expandModules > Enterprise Geocoding > Tools then click the database
resource icon for the country whose data you want to configure.

3. Click Add to install a new database or click Modify to change an existing database resource.
4. Specify a database resource name in the Database field. This name can be anything you choose.

You typically create a new database resource each time you receive an updated geocoding database
from Pitney Bowes Software so you may want to consider using the database date in the database
resource name.

5. Click Add. In the Name field, specify a name for this database resource. In the Path field specify the
folder that contains the database files. The database files are typically found in:
<InstallLocation>\IGEO-<CountryCode>\<Version>\data, where <InstallLocation> is
the directory you specified when you installed the database files, <CountryCode> is the two-letter
country code, and <Version> is the version number of the data. Some countries may have multiple
databases in the data directory, some of which you may have licensed and some you may have not.
Only specify the location of the data you have licensed.

For the Australia Geocoded National Address File (G-NAF) database, you must specify separate
database resources for the GNAF123 and GNAF456 folders. We recommend that you use both
databases to validate the existence of addresses but only use the GANF123 for parcel-level geocoding.
If you do not require parcel-level geocodes you can use the GANF456 database for geocoding.

If you are specifying a path for a user-defined database you must specify a path to a Pitney
Bowes Software provided database first. The first path in all database resources must be a
path for a Pitney Bowes Software provided database.

Note:

6. Click OK.
7. In the Pool size field, specify the maximum number of concurrent requests you want this database

to handle.

The optimal pool size varies by module. You will generally see the best results by setting the pool
size between one-half to twice the number of CPUs on the server, with the optimal pool size for most
modules being the same as the number of CPUs. For example, if your server has four CPUs you
may want to experiment with a pool size between 2 (one-half the number of CPUs) and 8 (twice the
number of CPUs) with the optimal size possibly being 4 (the number of CPUs).
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When modifying the pool size you must also consider the number of runtime instances specified in
the dataflow for the stages accessing the database resource. Consider for example a dataflow that
has a Geocode US Address stage that is configured to use one runtime instance. If you set the pool
size for the US geocoding database to four, you will not see a performance improvement because
there would be only one runtime instance and therefore there would only be one request at a time
to the database resource. However, if you were to increase the number of runtime instances of
Geocode US Address to four, you might then see an improvement in performance since there would
be four instances of Geocode US Address accessing the database resource simultaneously, therefore
using the full pool.

You should conduct performance tests with various settings to identify the optimal pool size
and runtime instance settings for your environment.

Tip:

8. Click OK.

Adding an Enterprise Routing Module Database Resource
Whenever you install a new database resource or modify an existing database resource you must define
it in the Management Console in order for it to become available on your system. This procedure describes
how to install or modify Enterprise Routing Module database resources. Routing database resources
are used by Find Nearest, Get Travel Boundary, Get Travel Cost Matrix, and Get Travel Directions.

1. If you haven't already done so, install the database files on your system. For instructions on installing
databases, see the Spectrum™ Technology Platform Installation Guide.

2. In Management Console, expand Modules > Enterprise Routing > Tools > Routing Database
Resources.

3. Click Add to install a new database or click Modify to change an existing database resource.
4. If you are adding a new database, enter a name for the database resource in the Name field. The

name can be anything you choose. You cannot modify the name of an existing database resource.
Changing the name of an existing database resource would cause any services or jobs that reference
the database resource to fail.

5. In the Path elements field, specify the folder that contains the database files. The database files can
be found in: <InstallLocation>\ERM-<CountryCode>\<Vintage>\<Type>\<Country>
where <InstallLocation> is the directory you specified when you installed the database files,
<CountryCode> is the two-letter country code, <Vintage> is the date of the data (for example, 2009.1),
<Type> is driving or pedestrian, and <Country> is the name of the country.

6. In the Pool size field, specify the maximum number of concurrent requests you want this database
to handle.

The optimal pool size varies by module. You will generally see the best results by setting the pool
size between one-half to twice the number of CPUs on the server, with the optimal pool size for most
modules being the same as the number of CPUs. For example, if your server has four CPUs you
may want to experiment with a pool size between 2 (one-half the number of CPUs) and 8 (twice the
number of CPUs) with the optimal size possibly being 4 (the number of CPUs).

When modifying the pool size you must also consider the number of runtime instances specified in
the dataflow for the stages accessing the database resource. Consider for example a dataflow that
has a Geocode US Address stage that is configured to use one runtime instance. If you set the pool
size for the US geocoding database to four, you will not see a performance improvement because
there would be only one runtime instance and therefore there would only be one request at a time
to the database resource. However, if you were to increase the number of runtime instances of
Geocode US Address to four, you might then see an improvement in performance since there would
be four instances of Geocode US Address accessing the database resource simultaneously, therefore
using the full pool.

You should conduct performance tests with various settings to identify the optimal pool size
and runtime instance settings for your environment.

Tip:

7. Click OK.
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Adding an Enterprise Tax Module Database Resource
Whenever you install a new database resource or modify an existing database resource you must define
it in the Management Console in order for it to become available on your system. This procedure describes
how to add or modify Enterprise Tax Module database resources.

1. If you haven't already done so, install the database files on your system. For instructions on installing
databases, see the Spectrum™ Technology Platform Installation Guide.

2. In Management Console, expand Modules > Enterprise Tax > Tools > Database Resources.
3. Click Add to install a new database or click Modify to change an existing database resource.
4. If you are adding a new database, enter a name for the database resource in the Name field. The

name can be anything you choose. You cannot modify the name of an existing database resource.
Changing the name of an existing database resource would cause any services or jobs that reference
the database resource to fail.

5. Specify the paths for the databases you want to include in this database resource.
6. In the Pool size field, specify the maximum number of concurrent requests you want this database

to handle.

The optimal pool size varies by module. You will generally see the best results by setting the pool
size between one-half to twice the number of CPUs on the server, with the optimal pool size for most
modules being the same as the number of CPUs. For example, if your server has four CPUs you
may want to experiment with a pool size between 2 (one-half the number of CPUs) and 8 (twice the
number of CPUs) with the optimal size possibly being 4 (the number of CPUs).

When modifying the pool size you must also consider the number of runtime instances specified in
the dataflow for the stages accessing the database resource. Consider for example a dataflow that
has a Geocode US Address stage that is configured to use one runtime instance. If you set the pool
size for the US geocoding database to four, you will not see a performance improvement because
there would be only one runtime instance and therefore there would only be one request at a time
to the database resource. However, if you were to increase the number of runtime instances of
Geocode US Address to four, you might then see an improvement in performance since there would
be four instances of Geocode US Address accessing the database resource simultaneously, therefore
using the full pool.

You should conduct performance tests with various settings to identify the optimal pool size
and runtime instance settings for your environment.

Tip:

7. Click OK.

Adding a Location Intelligence Module Centrus Database Resource
Whenever you install a new database resource or modify an existing database resource you must define
it in the Management Console in order for it to become available on your system. This procedure describes
how to install or modify a Location Intelligence Module database resource for a Centrus database.
Centrus data is used by Closest Site and Point in Polygon.

1. If you haven't already done so, install the database files on your system. For instructions on installing
databases, see the Spectrum™ Technology Platform Installation Guide.

2. In Management Console, expand Modules > Location Intelligence > Tools > Centrus Database
Resources.

3. Click Add to install a new database or click Modify to change an existing database resource.
4. If you are adding a new database, enter a name for the database resource in the Name field. The

name can be anything you choose. You cannot modify the name of an existing database resource.
Changing the name of an existing database resource would cause any services or jobs that reference
the database resource to fail.

5. In the Path field, enter the full path to the database file(s). Centrus database files have a .gsb
extension. The file names for .gsb files must be in all lower case on Unix and Linux systems for them
to be available to Spectrum™ Technology Platform.

6. In the Cache Size field, select the amount of memory to use to use to cache data. In general, the
larger the cache the better the performance. The options are:
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• None—Do not cache data.
• Medium—Use up to 5 MB of memory to cache data. Use this setting if there is a small amount of
memory available for caching.

• Large—Use up to 20 MB of memory to cache data. Use this setting if you are processing a large
number of records.

• Huge—Use up to 100 MB of memory to cache data. Use this setting if you are processing a large
number of records.

7. In the Pool size field, specify the maximum number of concurrent requests you want this database
to handle.

The optimal pool size varies by module. You will generally see the best results by setting the pool
size between one-half to twice the number of CPUs on the server, with the optimal pool size for most
modules being the same as the number of CPUs. For example, if your server has four CPUs you
may want to experiment with a pool size between 2 (one-half the number of CPUs) and 8 (twice the
number of CPUs) with the optimal size possibly being 4 (the number of CPUs).

When modifying the pool size you must also consider the number of runtime instances specified in
the dataflow for the stages accessing the database resource. Consider for example a dataflow that
has a Geocode US Address stage that is configured to use one runtime instance. If you set the pool
size for the US geocoding database to four, you will not see a performance improvement because
there would be only one runtime instance and therefore there would only be one request at a time
to the database resource. However, if you were to increase the number of runtime instances of
Geocode US Address to four, you might then see an improvement in performance since there would
be four instances of Geocode US Address accessing the database resource simultaneously, therefore
using the full pool.

You should conduct performance tests with various settings to identify the optimal pool size
and runtime instance settings for your environment.

Tip:

8. Click OK.The list of databases includes this information:

• Name—The name you have given the database. This is the name to use when referencing this
database from a stage or service.

• Path—The location of the database file.
• Cache size—The amount of memory to use to cache data from this database.
• Feature Type—Indicates the type of spatial data contained in the database (Points, Polygons, or
Lines). Points databases can be used with the Closest Site and Point In Polygon stages. Polygon
databases and Line databases can be used with Point In Polygon.

• Buffered—Indicates whether or not the database supports buffering, which is a Point in Polygon
feature that allows you to define areas that are close to the edge of a point, polygon, or line.

Adding a Location Intelligence Module Database Named Connection
Whenever you install a new database resource or modify an existing database resource you must define
it in the Management Console in order for it to become available on your system. This procedure describes
how to install or modify Location Intelligence Module spatial database resources. These resources are
defined by adding a Named Connection to your database. These named connections are stored in the
Location Intelligence Module repository, and can be used by all spatial services. Once you have added
a Named Connection to a database, the database then becomes available to create Named Tables (links
to tables in the database). Spatial database resources are used by Find Nearest, Query Spatial Data,
and Read Spatial Data.

Spectrum™ Technology Platform supports the following JDBC data types: BIGINT, BINARY, BIT, BLOB,
BOOLEAN, CHAR, DATE, DECIMAL, DOUBLE, FLOAT, INTEGER, LONGVARBINARY,
LONGVARCHAR, NULL, NUMERIC, REAL, SMALLINT, TIME, TIMESTAMP, TINYINT, VARBINARY,
VARCHAR. In addition, Spectrum™ Technology Platform supports the following Oracle data types:
SDO_GEOMETRY and MDSYS.SDO_GEOMETRY. These data types are handled as follows:

• string , INTEGER, long, FLOAT, and DOUBLE—No changes.
• DECIMAL—Converted to DOUBLE.
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• SDO_GEOMETRY and MDSYS.SDO_GEOMETRY—Converted to GEOMETRY.
• All others—Converted to STRING.

1. If you haven't already done so, install the database files on your system. For instructions on installing
databases, see the Spectrum™ Technology Platform Installation Guide.

2. In Management Console, expandModules > Location Intelligence > Tools >Named Connections.
Then click one of the following:

• Click Add to define a new database resource.
• Click Modify to change an existing database resource.

3. If you are adding a new Named Connection, enter a name for the resource in the Connection Name
field. The name can be anything you choose. You cannot modify the name of an existing database
resource. Changing the name of an existing database resource would cause any services or jobs
that reference the database resource to fail.

4. In the URL field, specify the JDBC connection URL to the database. This URL is in the format
jdbc:[subprotocol]:[node]/[databaseName]. For example:

• Oracle— jdbc:oracle:thin:@pbs-lim:8080:pbspatial
• SQL Server—jdbc:sqlserver://PBS-LIM:8080;databaseName=pbspatial
• PostGres/GIS— jdbc:postgresql://111.111.11.111:8080/pbspatial

5. In the User name field, specify the user for connecting to the database resource.
6. In the Password field, specify the password for the user connecting to the database resource.
7. In the Properties field, specify any database specific connection properties. Consult the database

documentation for property names and value types that can be appended to a connection string. For
example, property value networkProtocol and key tcp.

Oracle is currently the only database to support properties from the dialog. For the
PostGres/GIS and SQL Server append properties to the URL.

Note:

8. Click Test to make sure your connection is valid.
9. Click OK.

The Named Connection to the database resource now appears in the list of available resources in Find
Nearest, Query Spatial Data, and Read Spatial Data. These connections can also be used to access
Named Tables in database resources.

Adding a Location Intelligence Module Named Table Resource
Location Intelligence Module stages, services, and operations require Named Tables to access various
types of data. Named Tables are a resource that point to data, and can be used to access MapInfo TAB
(including View tables), Shape, JDBC database files (includes XY tables), or FDO database files (including
text tables). This procedure describes how to add or modify Location Intelligence Module Named Table
resources. These named tables are stored in the Location Intelligence Module repository, and can be
used by all spatial services.

Only a user account with full permissions to named resources has the ability to add Named
Tables using the Management Console. For more information on assigning permissions, refer
to the "Managing Security" chapter in the Spectrum Spatial Administration Guide.

Note:

1. If you haven't already done so, install the data on your system. For instructions on installing databases,
see the Spectrum™ Technology Platform Installation Guide. For adding Named Tables that are in a
database resource, youmust first add the NamedConnection to the database resource. For information
on adding Named Connections, see Adding a Location Intelligence Module Database Named
Connection on page 43.

2. In Management Console, expandModules > Location Intelligence > Tools >Named Tables. Then
click one of the following:

• Click Add to define a new table resource.
• Click Modify to change an existing table resource.
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• Click Delete to remove an existing table resource.

3. If you are adding a new Named Table, enter the repository path and name for the named table
resource in the Named table name field. You must prepend the name of the named table with where
in the repository the named table is going to be created. For example, if you are creating the World
named table and are creating this named table in the NamedTables folder in the repository, the
name you would enter in theNamed table name field would be /NamedTables/World. You cannot
modify the name of an existing named table resource. Changing the name of an existing resource
would cause any services or jobs that reference the resource to fail.

4. In the Named table type field select one of the following:

• Tab—Choose this option if the data is in MapInfo TAB format on the file system.
• Shape—Choose this option if the spatial data is in ESRI Shape file format.
• Database—Choose this option if the data is in a JDBC database, and have created a Named
Connection.

• FDO—Choose this option if the data is in a FDO (SQLite) database, and have created a Named
Connection.

• View—Choose this option if the data is in MapInfo TAB format, and are using a SQL statement to
display a particular view of the table.

When modifying a Named Table that has not been created using the Management Console
(i.e., manually created and uploaded using the Named Resource Service or WebDav) the

Note:

resource typemight display as unknown. In this instance, the database connection information
(JDBC or FDO) for the table has not been stored in the Management Console. To resolve
the connection information, create a Named Connection in the Management Console to match
the connection information in the Named Table you are trying to modify, then apply the new
connection to the Named Table.

5. If you selected Tab as the source type, specify the path to the TAB file in the Path field.
6. If you selected Shape File as the source type, specify the path to the shape file in the Path field.
7. If you selected Database as the source type, complete these fields:

• Connection name—The named connection to the database that defines a set of parameters used
to access the database. Select a name from the list to specify an existing named connection.

• Schema—The database schema object. This is typically the same as the user name.
• Table—The table in the selected database containing the data you want to read into the dataflow.
• XY—Check this box if your data is an XY table. Specify the X and Y columns and the coordinate
system for these columns. In addition, select the styling of this table by either selecting None,
defining a Style column, or defining a Named style. If selecting a named style, you must define
an existing named style in the repository, and include the entire path from the root, e.g.,
/NamedStyles/PointStylePin.

8. If you selected FDO as the source type, complete these fields:

• Connection name—The named connection to the database that defines a set of parameters used
to access the database. Select a name from the list to specify an existing named connection.

• Schema—The database schema object. For FDO this should be Default.
• Table—The table in the selected database containing the data you want to read into the dataflow.

9. If you selected View as the source type, specify the SQL query in the SQL field. A View named table
provides the ability to create a layer in a map based on the query in the named table at runtime.
Using a View, you can create a named view containing a filtered view from multiple resources, based
on a SQL query. Since your SQL query contains a named table (e.g., select Country,Capital, Obj
from "/NamedTables/WorldcapTable" where Country='INDIA') you can use views on any datasource,
as the named table might have a datasource type as TAB, XY, Oracle, SQL Server, etc.
Once your SQL query is complete, click ValidateQuery to confirm your SQL statement is valid.

10. Click OK.

The named table resource now appears in the list of available resources in Find Nearest, Query Spatial
Data, and Read Spatial Data.
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Adding a Universal Addressing Module Database Resource
Whenever you install a new database resource or modify an existing database resource you must define
it in the Management Console in order for it to become available on your system. This procedure describes
how to add or modify database resources used by Get Candidate Addresses, Get City State Province,
Get Postal Codes, Validate Address.

If you want to configure a database resource for Validate Address Global, seeAdding a Universal
Addressing Module Global Database Resource on page 46.

Note:

1. If you haven't already done so, install the database files on your system. For instructions on installing
databases, see the Spectrum™ Technology Platform Installation Guide.

2. In Management Console, expand Modules > Universal Addressing > Tools Click the icon for the
country whose database resource you want to configure.

If you want to define a Global Database Resource for use with Validate Address Global, see
Adding a Universal Addressing Module Global Database Resource on page 46.

Note:

3. Click Add to install a new database or click Modify to change an existing database resource.
4. If you are adding a new database, enter a name for the database resource in the Name field. The

name can be anything you choose. You cannot modify the name of an existing database resource.
Changing the name of an existing database resource would cause any services or jobs that reference
the database resource to fail.

5. Specify the paths to the database files.
6. In the Pool size field, specify the maximum number of concurrent requests you want this database

to handle.

The optimal pool size varies by module. You will generally see the best results by setting the pool
size between one-half to twice the number of CPUs on the server, with the optimal pool size for most
modules being the same as the number of CPUs. For example, if your server has four CPUs you
may want to experiment with a pool size between 2 (one-half the number of CPUs) and 8 (twice the
number of CPUs) with the optimal size possibly being 4 (the number of CPUs).

When modifying the pool size you must also consider the number of runtime instances specified in
the dataflow for the stages accessing the database resource. Consider for example a dataflow that
has a Geocode US Address stage that is configured to use one runtime instance. If you set the pool
size for the US geocoding database to four, you will not see a performance improvement because
there would be only one runtime instance and therefore there would only be one request at a time
to the database resource. However, if you were to increase the number of runtime instances of
Geocode US Address to four, you might then see an improvement in performance since there would
be four instances of Geocode US Address accessing the database resource simultaneously, therefore
using the full pool.

You should conduct performance tests with various settings to identify the optimal pool size
and runtime instance settings for your environment.

Tip:

7. Click OK.

Adding a Universal Addressing Module Global Database Resource
Whenever you install a new database resource or modify an existing database resource you must define
it in the Management Console in order for it to become available on your system. This procedure describes
how to install or modify database resources for use with Validate Address Global.

1. If you have not already done so, install the database files on your system and enter the unlock key
for the data in
<SpectrumLocation>\server\modules\addressglobal\conf\unlockcodes.txt. For
instructions on installing databases, see the Spectrum™ Technology Platform Installation Guide.

You must specify an unlock key in the file unlockcodes.txt before creating the database
resource.

Note:
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2. In Management Console, expand Modules > Universal Addressing > Tools > Global Database
Resources.

3. Click Add to install a new database or click Modify to change an existing database resource.
4. If you are adding a new database, enter a name for the database resource in the Name field. The

name can be anything you choose. You cannot modify the name of an existing database resource.
Changing the name of an existing database resource would cause any services or jobs that reference
the database resource to fail.

5. In the Cache size field, choose the amount of memory you want to use for speeding up file system
lookups in reference data that has not been preloaded. (Preloading is discussed below.) One of the
following:

• None—Do not cache data.
• Small—Choose this option if you need to reduce the amount of memory used by Validate Address
Global.

• Large—This is the recommended setting. Use this setting unless all reference data is preloaded
(in which case you may choose a cache size of None) or you want to reduce the amount of memory
used by Validate Address Global.

6. In the Path elements field, specify the folder that contains the database files. To specify path elements,
a) Click Add (or Modify to change an existing path).
b) In the Path field specify the folder that contains the database files.
c) Click Add to specify country preferences (or Modify to change an existing preference).

7. Select a database type. The options are:

• Batch Interactive— (Default) Used for all non-FastCompletion and non-Certified databases.
• FastCompletion—Validation mode used in quick address entry applications that allows input of
truncated data in several address fields and will generate suggestions for this input. FastCompletion
can also be used to create suggestions while you type.

FastCompletion databases do not support extended parsing.Note:

• Certified—Validation mode used in batch processing environments for Australian mail. Validate
Address Global is certified by Australia Post's Address Matching Approval System (AMAS). It will
standardize and validate your mail against the Postal Address File, providing postal discounts and
allowing for the least amount of undeliverable pieces.

8. Select a preloading type.
Preloading loads database data into memory, which can improve performance. Since large amounts
of memory may be allocated during preloading, it might take some time to load the databases into
memory. The options are:

• None—No data is preloaded into memory. Use this option on machines with limited memory.
(Default)

• Partial—Partial preloading loads the metadata and indexing structures into memory. The reference
data itself remains on the hard drive. Partial preloading offers some performance enhancements
and is an alternative when not enough memory is available to fully load the desired databases.
Partial preloading may not be supported for all databases.

• Full—Full preloading moves the entire reference database into memory. This may need a significant
amount of memory for countries with large databases such as the USA or the United Kingdom,
but it will increase the processing speed significantly.

9. Choose one of the following:

• Make default—Make the selected database type and preloading type the default for all countries
in the folder.

• Apply to selected countries only—Apply this database type and preloading type only to the selected
countries.

10. Click OK.
11. In the Pool size field, specify the maximum number of concurrent requests you want this database

to handle.
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The optimal pool size varies by module. You will generally see the best results by setting the pool
size between one-half to twice the number of CPUs on the server, with the optimal pool size for most
modules being the same as the number of CPUs. For example, if your server has four CPUs you
may want to experiment with a pool size between 2 (one-half the number of CPUs) and 8 (twice the
number of CPUs) with the optimal size possibly being 4 (the number of CPUs).

When modifying the pool size you must also consider the number of runtime instances specified in
the dataflow for the stages accessing the database resource. Consider for example a dataflow that
has a Geocode US Address stage that is configured to use one runtime instance. If you set the pool
size for the US geocoding database to four, you will not see a performance improvement because
there would be only one runtime instance and therefore there would only be one request at a time
to the database resource. However, if you were to increase the number of runtime instances of
Geocode US Address to four, you might then see an improvement in performance since there would
be four instances of Geocode US Address accessing the database resource simultaneously, therefore
using the full pool.

You should conduct performance tests with various settings to identify the optimal pool size
and runtime instance settings for your environment.

Tip:

12. Repeat as needed to specify different database type and preloading settings for different countries.
For example, if you have several countries in a folder you could specify a default database type of
FastCompletion and preloading type of Partial then click OK. Then click Add, specify a default
database type of FastCompletion and preloading type of Full for those few countries that you expect
to use often, and click OK again.

13. When you are done defining database type and preloading options, click OK.
14. If necessary, define additional database paths. Click OK if you are done.

The database resource now appears in the list of available database resources for Validate Address
Global.

Optimizing Database Resources
Database resources contain reference data used by certain stages, such as postal data used to validate
addresses, or geocoding data used to geocode addresses. These database resources can be configured
to accept multiple concurrent requests from the dataflow stages or services that use them, thereby
improving the performance of the dataflows or service requests. You can modify the number of concurrent
requests that a database resource will accept by modifying the pool size of a database resource. The
pool size determines the maximum number of concurrent requests that the database resource can
process. By default, database resources have a pool size of 4, meaning the database resource can
process four requests simultaneously. However, you can configure a database resource to have a
different pool size.

1. Open Management Console.
2. UnderModules, expand the module for which you want to optimize database resource performance.

Then expand Tools and select the database resource.
3. Select the database resource you want to optimize and click Modify.
4. In the Pool size field, specify the maximum number of concurrent requests you want this database

to handle.

The optimal pool size varies by module. You will generally see the best results by setting the pool
size between one-half to twice the number of CPUs on the server, with the optimal pool size for most
modules being the same as the number of CPUs. For example, if your server has four CPUs you
may want to experiment with a pool size between 2 (one-half the number of CPUs) and 8 (twice the
number of CPUs) with the optimal size possibly being 4 (the number of CPUs).

When modifying the pool size you must also consider the number of runtime instances specified in
the dataflow for the stages accessing the database resource. Consider for example a dataflow that
has a Geocode US Address stage that is configured to use one runtime instance. If you set the pool
size for the US geocoding database to four, you will not see a performance improvement because
there would be only one runtime instance and therefore there would only be one request at a time
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to the database resource. However, if you were to increase the number of runtime instances of
Geocode US Address to four, you might then see an improvement in performance since there would
be four instances of Geocode US Address accessing the database resource simultaneously, therefore
using the full pool.

You should conduct performance tests with various settings to identify the optimal pool size
and runtime instance settings for your environment.

Tip:

Related Links
Optimizing Services on page 68

Deleting a Database Resource
1. Before deleting a database, verify that there are no jobs or services using the database. Deleting a

database that is referenced by jobs/services will cause those jobs/services to fail.
2. Click the Database Resources icon under the Tools node of the module for which you want to define

a database.
3. Click Delete.

This process makes the database unavailable to Spectrum™ Technology Platform jobs but
it does not delete the database files from your system.

Note:
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Introduction to Resources
In Spectrum™ Technology Platform, a resource is a connection to a data source that you want to use
as input to, or output from, a dataflow. There are three kinds of resources:

• Databases
• File servers
• Web services

If you want to access data in an external resource you must first define a connection to the resource
using Management Console. For example, if you want to read data from an XML file into a dataflow, and
the XML file is located on a remote file server, you would have to define a connection to the file server
before you can define the input XML file in a dataflow. Similarly, if you want to write dataflow output to
a database, you must first define the database as an external resource.

If you want to read from or write to data located in a file on the Spectrum™ Technology Platform
server itself there is no need to define a connection.

Note:

Databases

Adding or Modifying a Database Connection
A database connection enables Spectrum™ Technology Platform to read and write data to a database.
You must define a database connection in order to create dataflows that read data from the database
or write data to the database.

1. Open the Management Console.
2. Expand Resources then click Connections.
3. Click Add or Modify. The Connection Properties dialog box will appear.
4. Enter a name for the connection in the Connection name field. This can be anything you choose.
5. Select the appropriate database type in the Database driver field.

Spectrum™ Technology Platform comes with SQL Server and Oracle connection types. If you want
to connect to a different database type, you must define a JDBC driver before configuring the database
connection.

6. Complete the fields in the Connection Options table. This includes the host, port, instance, user
name, and password.

7. Test the connection by clicking Test.
8. Click OK.

Deleting a Database Connection
1. Open the Management Console.
2. Expand Resources then click Connections.
3. Highlight the connection you want to update and clickDelete. You will receive a confirmation message

asking if you wish to delete the connection.
4. Click OK to confirm.
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JDBC Drivers

Adding or Modifying a JDBC Driver
Spectrum™ Technology Platform can read data from, and write data to, any database using a JDBC
driver. To access data using a JDBC driver you must first define the driver, then create a database
connection that uses the driver. The following procedure describes how to create or modify a JDBC
driver.

JDBC driver settings are very specific and require total accuracy to function. Ensure you have
the correct information from your database/database driver provider before adding a JDBC driver.

Note:

1. Open the Management Console.
2. Expand Resources then click JDBC Drivers.
3. Click Add to create a new JDBC driver connection. If you want to modify an existing drvier, select

the driver you want to modify then click Modify.

Spectrum™ Technology Platform comes with three predefined JDBC drivers: Internal (which
is used by the system), SQL Server, and Oracle. You cannot modify or delete these.

Note:

4. In the JDBC driver configuration name field, enter a name for the driver. The name can be anything
you choose.

5. In the JDBC driver class name field, enter the Java class name of the driver. You can typically find
the class name in your JDBC driver's documentation.

For example, to use the Microsoft JDBC driver with an SSL connection to a SQL database, you might
enter the following:

com.microsoft.sqlserver.jdbc.SQLServerDriver

6. In the Connection string template field, enter the template to use for the connection string.

For example, to enable an SSL connection to a SQL database, you would enter the following:

jdbc:sqlserver://${host}:${port};databaseName=${instance};encrypt=true;TrustServerCertificate=true

7. In the Driver files section, click Add.
8. Navigate to and select the appropriate driver and click Save.
9. In the Connection Properties section, click Add. The JDBC Connection Property dialog box will

appear.
10. In the Label field, enter the property's label. The label can be any name you choose. For example,

username.
11. In the Property token field, enter the token to use in the URL. For example, user.

You will need to enter both user and password property tokens for every JDBC connection
you create.

Note:

12. Click OK.

Deleting a JDBC Driver
1. Open the Management Console.
2. Expand Resources then click JDBC Drivers.
3. Select an existing JDBC driver and click Delete. The Confirm Delete dialog box will appear.

If any connections are using this driver, you will be notified which connections are using it
and you cannot delete the driver.

Note:
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Supported Database Data Types
Spectrum™ Technology Platform supports the following data types commonly used in databases:

A numeric data type that supports 38 decimal points of precision. Use this data type
for data that will be used in mathematical calculations requiring a high degree of

bigdecimal

precision, especially those involving financial or geospatial data. The bigdecimal data
type supports more precise calculations than the double data type.

A logical type with two values: true and false.boolean

A data type that contains a month, day, and year. For example, 2012-01-30 or January
30, 2012. You can specify a default date format in Management Console.

date

A data type that contain a month, day, year, and hours, minutes, and seconds. For
example, 2012/01/30 6:15 PM.

datetime

A numeric data type that contains both negative and positive double precision numbers
between 2-1074 and (2-2-52)×21023. In E notation, the range of values is 4.9E-324 to

double

1.7976931348623157E308. For information on E notation, see
en.wikipedia.org/wiki/Scientific_notation#E_notation.

A numeric data type that contains both negative and positive single precision numbers
between 2-149 and (2-223)×2127. In E notation, the range of values is 1.4E-45 to

float

3.4028235E38. For information on E notation, see
en.wikipedia.org/wiki/Scientific_notation#E_notation.

A numeric data type that contains both negative and positive whole numbers between
-231 (-2,147,483,648) and 231-1 (2,147,483,647).

integer

A numeric data type that contains both negative and positive whole numbers between
-263 (-9,223,372,036,854,775,808) and 263-1 (9,223,372,036,854,775,807).

long

A sequence of characters.string

A data type that contains the time of day. For example, 21:15:59 or 9:15:59 PM.time

Other database data types are automatically mapped to one of the supported data types as follows:

Table 1: Mapping of Database Data Types to Supported Data Types

Supported Data TypeDatabase Data Type

Date/Time Types

datetimeTIMESTAMP

String Types

stringCHAR

stringCLOB

stringLONGVARCHAR

stringNCHAR

stringNVARCHAR

stringVARCHAR

Numeric Types

longBIGINT

doubleDECIMAL
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Supported Data TypeDatabase Data Type

doubleFLOAT

bigdecimalNUMERIC

floatREAL

integerSMALLINT

integerTINYINT

Boolean Types

booleanBIT

File Servers

Connecting to an FTP File Server
If you need to read data from, or write data to, files on an FTP server you must define a connection to
the file server using Management Console. Once you do this, you can create dataflows in Enterprise
Designer that can read data from, and write data to, files on the file server.

1. Open the Management Console.
2. Expand Resources then click File Servers.
3. Click Add.
4. In the Connection name field, enter a name for the new connection . The name can be anything

you choose.
5. In the Host field, enter the name or IP address of the FTP server.
6. In the Port field, enter the network port number.
7. In the Type field, choose FTP.
8. In the User name field, enter the user name to use when authenticating to the FTP server. This is

required only if the FTP server requires it.
9. In the Password field, enter the password to use when authenticating to the FTP server. This is

required only if the FTP server requires it.
10. Click OK.
11. If you wish to test the server, highlight the connection you want to test and click the Test button on

the File Servers dialog box.

After you have defined a connection to a file server, it becomes available in source and sink stages in
Enterprise Designer, such as Read from File, Write to File, and so on. You can select the FTP server
when you click Remote Machine when defining a file in a source or sink stage.

Connecting to a Hadoop Distributed File System
Hadoop Distributed File System (HDFS) is an open source distributed file system. It provides
high-performance access to large data sets and can be run on inexpensive hardware. If you have an
HDFS system you can configure Spectrum™ Technology Platform to read data from, or write data to,
files on your HDFS cluster by defining a connection to the HDFS cluster using Management Console.
Once you do this, you can create dataflows in Enterprise Designer that can access files on HDFS.

For more information on HDFS, see the documentation available on the Apache Hadoop project
website: hadoop.apache.org.

Note:
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1. Open the Management Console.
2. Expand Resources then click File Servers.
3. Click Add.
4. In the Connection name field, enter a name for the new connection . The name can be anything

you choose.
5. In the Host field, enter the name or IP address of the NameNode in the HDFS cluster.
6. In the Port field, enter the network port number.
7. In the Type field, choose HDFS.
8. Under User, select one of the following:

Choose this option if authentication is enabled in your HDFS cluster. This
option will use the user credentials that the server runs under to
authenticate to HDFS.

Server user

Choose this option if authentication is disabled in your HDFS cluster.User name

9. In the Protocol field select one of the following:

Select this option if the HDFS cluster is running HDFS 1.0 or later. This protocol
supports both read and write operations.

WEBHDFS

Select this option if the HDFS cluster is running a version older than HDFS 1.0,
or if your organization does not allow the WEBHDFS protocol. This protocol only
supports the read operation.

HFTP

Select this option to access Hadoop archive files. If you choose this option, specify
the path to the archive file in the Path field. This protocol only supports the read
operation.

HAR

10. If you selected the WEBHDFS protocol you can specify the following advanced options.

Specifies howmany data nodes to replicate each block to. For example, the default
setting of 3 replicates each block to three different nodes in the cluster. The
maximum replication factor is 1024.

Replication
factor

Specifies the size of each block. HDFS breaks up a file into blocks of the size you
specify here. For example, if you specify the default 64 MB, each file is broken up

Block size

into 64 MB blocks. Each block is then replicated to the number of nodes in the
cluster specified in the Replication factor field.

Specifies the level of access to files written to the HDFS cluster by Spectrum™

Technology Platform. You can specify read and write permissions for each of the
following:

File
permissions

The Execute permission is not applicable to Spectrum™ Technology
Platform.

Note:

This is the user specified above, either Server user or the user
specified in the User name field.

User

This refers to any group of which the user is a member. For
example, if the user is john123, then Group permissions apply to
any group of which john123 is a member.

Group

This refers to any other users as well as groups of which the
specified user is not a member.

Other

11. Click OK.
12. If you wish to test the server, highlight the connection you want to test and click the Test button on

the File Servers dialog box.

After you have defined a connection to an HDFS cluster, it becomes available in source and sink stages
in Enterprise Designer, such as Read from File, Write to File, and so on. You can select the HDFS cluster
when you click Remote Machine when defining a file in a source or sink stage.
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Modifying a File Server
1. Open the Management Console.
2. Expand Resources then click File Servers.
3. Highlight the server you want to update and click Modify.
4. Make the appropriate changes to the server and click OK.

Modifying a configuration may cause any dataflows reference that configuration to no longer
function properly.

Note:

Deleting a File Server
1. Open the Management Console.
2. Expand Resources then click File Servers.
3. Highlight the file server you want to delete and click Delete. You will receive a confirmation message

asking if you wish to delete the server.
4. Click OK to confirm.

Deleting a file server will cause any dataflows referencing that file server to no longer function
properly.

Note:

External Web Services
External web services are data processing services provided over the Internet by a third party. You can
define external web services in the Management Console and then use them as a stage in a dataflow,
or as a service exposed on your Spectrum™ Technology Platform server. This allows you to incorporate
almost any kind of processing into your Spectrum™ Technology Platform environment, since there are
a wide variety of web services available on the Internet.

External web services show up in the palette in Enterprise Designer and you can work with them as you
do other stages. The following shows an example of two external web services,
CompanyReviewsWebService and TimeZoneLookupWebService.
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Spectrum™ Technology Platform supports external web services that use REST, SOAP 1.1, or SOAP
1.2 messaging.

Adding a SOAP Web Service
This topic describes how to define a connection to an external third-party web service using the SOAP
protocol.

1. Open the Management Console.
2. Expand the Resources node, then click External Web Services.
3. Click Add.
4. In the Name field, enter the name you want to give the external web service. This will be the stage

name shown in Enterprise Designer and the service name on the Spectrum™ Technology Platform
server. The name can be anything you want but must not already be used by another web service
on your system.

5. Under External service type, select SOAP.
6. In the Timeout field, enter the number of seconds that are allowed to elapse before a request

submitted to the web service times out.

The timeout value you specify here applies to any request made to the web service. This
includes not only transactions made against the exposed web service, but also requests

Note:

made in the course of configuring the web service. Such configuration requests are invoked
by clickingRefresh, choosing a new item in theOperation list, and running preview. Timeouts
can occur when performing any of these actions. If timeouts do occur, increasing the Timeout
value can help to avoid them, provided the web service is actually up and running.

7. If you want to make the web service available to use in dataflows and to access as a Spectrum™

Technology Platform service:
a) Check the Expose as service box.
b) If you want the web service exposed as a SOAP web service, check the SOAP box. The web

service will then be listed at http://<ServerName>:<Port>/soap.
c) If you want the web service exposed as a REST web service, check the REST box. The web

service will then be listed at http://<ServerName>:<Port>/rest.

8. In the URL field, enter the URL of the web service's WSDL.
9. Enter a user name and password if they are required to access the external web service.
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10. Click Refresh to populate the Operation list with the operations that are available from the web
service.

Some web services require you to provide a user name and password before you can access
them. In this case you must provide the required credentials prior to clicking Refresh.
Otherwise, the refresh operation will fail.

Note:

11. In the Operation list, select the web service operation you want to perform.

When you select a web service operation in the Operation list, the field names for the operation
request and response are listed on the Request and Response tabs.

12. Check theUse WS-Security box to apply security to your web service by sending credentials through
the header of the SOAP message.

13. If the web service supports request headers, configure the Request Header tab as follows. If it does
not, go to step 14 on page 59.
a) Select the header parameters you want to include in the request by checking or clearing the

boxes. If a check box is checked and grayed out, it means that the parameter is required and
you cannot disable it.

b) In the Value column, specify the value you want to use for each parameter.

14. On the Request tab (or Request Body tab if the web service supports request headers), specify the
settings and values you want for the request fields.
a) To use a subset of the available request fields, select an XPath location in the Filter field.

All XPath location paths that match the selected path, and any descendant paths, are displayed
in the table and will be included in the request.

b) In the Field Name column, enter the field name you want to reference each request field. This
is the name that will be used for input field name for the resulting Spectrum™ Technology Platform
service, if the field is exposed.

Each XPath location in the table is associated with a corresponding request field. The request
field is given an initial default name provided by the external web service. For each request field,
you can either accept the default name or enter a new name.

c) In the Default Value column, specify a default value for each request field, if desired.
d) Select the Expose option for each request field you want to expose as an available input field in

the resulting Spectrum™ Technology Platform service. If you want to expose all request fields,
select the Expose option in the table heading row.

e) If you want to view a template of the XML that will be sent as a request to the external web service,
click View Template.

15. On the Response tab, specify the settings and values you want for the response fields.
a) Select the Return response XML as text option if you want the external web service response

to be returned as a single field named SoapResponse. A template of the XML response is
displayed. Proceed to step 16 on page 60.

If you do not select the Return response XML as text option, the web service response is
returned as individual fields based on the specified mapping of field names to XPath location
paths. Continue with the remaining steps below.

b) If you want to filter the list of fields displayed, select an XPath in the Filter field.
All XPath location paths that match the selected path, and any descendant paths, are displayed
in the table and will be included in the response.

c) In the Field Name column, change the default field name, if desired.

Each XPath location path in the table is associated with a corresponding response field that is
given an initial default name provided by the external web service. For each response field, you
can either accept the default name or enter a new name.

d) Select the Expose option for each response field you want to expose as an available output field
in the resulting Spectrum™ Technology Platform service. If you want to expose all response fields,
select the Expose option in the table heading row.

A field which has its Expose option selected will be returned in the response from the external
web service. Each field is mapped to an XPath location provided by the external web service. If
the fields that have their Expose option selected are mapped to XPath locations that are all at
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the same level, then individual records will be returned for the fields. However, if the exposed
fields are mapped to XPath locations at different levels, then a hierarchical data object will be
returned.

e) If you want to view a template of the XML that will be sent as a response from the external web
service, click View Template.

16. On the Preview tab, enter any test data you would like to submit to the external web service, then
click Preview to see the web service's response.

17. Click OK to save the external web service.

Related Links
External Web Services on page 57

Adding a REST Web Service
This topic describes how to define a connection to an external third-party web service using the REST
protocol.

1. Open the Management Console.
2. Expand the Resources node, then click External Web Services.
3. Click Add.
4. In the Name field, enter the name you want to give the external web service. This will be the stage

name shown in Enterprise Designer and the service name on the Spectrum™ Technology Platform
server. The name can be anything you want but must not already be used by another web service
on your system.

5. Under External service type, select REST.
6. In the Timeout field, enter the number of seconds that are allowed to elapse before a request

submitted to the web service times out.

The timeout value you specify here applies to any request made to the web service. This
includes not only transactions made against the exposed web service, but also requests

Note:

made in the course of configuring the web service. Such configuration requests are invoked
by clickingRefresh, choosing a new item in theOperation list, and running preview. Timeouts
can occur when performing any of these actions. If timeouts do occur, increasing the Timeout
value can help to avoid them, provided the web service is actually up and running.

7. If you want to make the web service available to use in dataflows and to access as a Spectrum™

Technology Platform service
a) Check the Expose as service box.
b) If you want the web service exposed as a SOAP web service, check the SOAP box. The web

service will then be listed at http://<ServerName>:<Port>/soap.
c) If you want the web service exposed as a REST web service, check the REST box. The web

service will then be listed at http://<ServerName>:<Port>/rest.

8. In the URL field, enter the URL of the web service.

You may include parameters in the URL if you want to pre-populate the Request and Response
tabs with the parameters used by the web service. For example, let's say you are defining an external
web service for a web service that provides reviews of businesses. You might enter a URL like this:

http://ws.someprovider.com/business_reviews?term=insurance&location=207325

Based on this, the external web service you define would have two fields, term and location. If
you omit parameters from the URL you can specify them later in this procedure.

9. Enter a user name and password if they are required to access the external web service.
10. Click Refresh to populate the Operation list with the operations that are available from the web

service.

Some web services require you to provide a user name and password before you can access
them. In this case you must provide the required credentials prior to clicking Refresh.
Otherwise, the refresh operation will fail.

Note:
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11. In the Operation list, select the web service operation you want to perform.

When you select a web service operation in the Operation list, the field names for the operation
request and response are listed on the Request and Response tabs.

12. On the Request tab, specify the settings and values you want for the request fields.
a) The parameter list shows the parameters contained in the URL you previously entered. If you

want to add additional parameters, click Add. If you want to delete a parameter, select it in the
table and click Delete.

b) In the Field Name column, enter the field name you want to reference each parameter. This is
the name that will be used for input field name for the resulting Spectrum™ Technology Platform
service, if the field is exposed.

c) Specify a default value for each request field, if desired.
d) Select the Expose option for each request field you want to expose as an available input field in

the resulting Spectrum™ Technology Platform service. If you want to expose all request fields,
select the Expose option in the table heading row.

e) If you want to view a template of the request URL that will be sent to the external web service,
click View Template.

13. On the Response tab, specify the type response returned by the third-party web service.

Spectrum™ Technology Platform will return a single field named RestResponse
containing the REST response. This option works with all response types.

Text

Select this option if the third-party web service returns delimited data such as CSV.
Spectrum™ Technology Platform will parse the data and return it as individual
fields.

Delimited

Select this option if the third-party web service returns XML. Spectrum™ Technology
Platform will parse the data and return it as individual fields.

XML

Select this option if the third-party web service returns JSON. Spectrum™

Technology Platform will parse the data and return it as individual fields.
JSON

14. On the Preview tab, enter any test data you would like to submit to the external web service, then
click Preview.

15. Click OK to save the external web service.

Related Links
External Web Services on page 57

Renaming an External Web Service
Renaming an external web service will break existing jobs/services that reference the external web
service. If no jobs/services reference the external web service, or if you want to change existing
jobs/services to reference a different external web service or the new name, you can safely rename the
external web service.

1. In Management Console, expand the Resources node, then click External Web Services.
2. Highlight the external web service you want to rename and click Rename.
3. Confirm that you want to rename the external web service by clicking OK.
4. Enter a new name for the external web service, then click OK.

Related Links
External Web Services on page 57

Deleting an External Web Service
Deleting an external web service will break existing jobs/services that reference the external web service.
If no jobs/services reference the external web service, or if you want to change existing jobs/services to
reference a different external web service, you can safely delete the external web service.

1. In Management Console, expand the Resources node, then click External Web Services.
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2. Highlight the external web service you want to delete and clickDelete. You will receive a confirmation
message asking if you wish to delete the external web service.

3. Click OK to confirm.

Related Links
External Web Services on page 57

Using a Windows Mapped Drive
If you are running the Spectrum™ Technology Platform server on a Windows server you can provide
Enterprise Designer and Management Console users with access to data stored on a mapped drive.
For example, you may want to design dataflows that read data from, or write data to, files located on a
drive mapped to the Windows server running Spectrum™ Technology Platform. Since the Spectrum™

Technology Platform server runs as a Windows service under a particular user account (often the Local
System account) you need to define the mapped drive in the server's start-up process in order for it to
be visible in Enterprise Designer and Management Console.

1. Stop the Spectrum™ Technology Platform server.
2. Under the folder where the Spectrum™ Technology Platform server is installed, go to

server\bin\wrapper. For example, C:\Program Files\Pitney
Bowes\Spectrum\server\bin.

3. Open the file wrapper.conf in a text editor.

In the following steps you will add new properties to this file. It is important that you
follow these instructions precisely and only add and modify the parameters described
in the following steps. Do not modify any of the other parameters in this file.

Important:

4. Add the following lines:

wrapper.share.1.location
wrapper.share.1.target
wrapper.share.1.type
wrapper.share.1.account
wrapper.share.1.password

5. In the wrapper.share.1.location property, specify the location of the mapped drive in UNC
format.

Do not include a trailing backslash in the UNC.Note:

For example,

wrapper.share.1.location=\\myserver\share

6. In the wrapper.share.1.target property, specify the drive letter to assign to this mapped drive.

For example,

wrapper.share.1.target=Y:

7. In the type property, specify DISK.

For example,

wrapper.share.1.type=DISK

8. If the share you are connecting to requires a user name and password, specify the user name in the
wrapper.share.1.account property and specify the password in the
wrapper.share.1.password property.
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For example,

wrapper.share.1.account=domain\user123
wrapper.share.1.password=mypassword1

If the Spectrum™ Technology Platform server service is running under the Local System
user, you cannot specify a user name and password. If the share requires a user name and
password you must modify the service to run under a different account.

Note:

Example of Mapped Drive Properties in Wrapper.conf

The following example shows twomapped drives being defined in the wrapper.conf
file.

wrapper.share.1.location=\\myserver\data
wrapper.share.1.target=Y:
wrapper.share.1.type=DISK
wrapper.share.1.account=sample\user
wrapper.share.1.password=samplepass
wrapper.share.2.location=\\myserver\moredata
wrapper.share.2.target=Z:
wrapper.share.2.type=DISK
wrapper.share.2.account=sample\user
wrapper.share.2.password=samplepass
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Services
A service is a dataflow that you can access as web services or using the Spectrum™ Technology Platform
API. You pass a record to the service and optionally specify the options to use when processing the
record. The service processes the data and returns the data.

Some services become available when you install a module. For example, when you install the Universal
Addressing Module the service ValidateAddress becomes available on your system. In other cases, you
must create a service in Enterprise Designer then expose that service on your system as a user-defined
service. For example, the Location Intelligence Module's stages are not available as services unless you
first create a service using the module's stages.

Specifying Default Service Options
Default service options control the default behavior of each service on your system. You can specify a
default value for each option in a service. The default option setting takes effect when an API call or web
service request does not explicitly define a value for a given option. Default service options are also the
settings used by default when you create a dataflow in Enterprise Designer using this service.

1. Open Management Console.
2. Expand Modules, then expand the module that contains the service for which you want to specify

default options.
3. Click the service you want.
4. Set the options for the service.
5. Select File > Save.

Previewing a Service
You can preview the results of a service using the Preview tab. Preview can be useful in helping you
decide what options to specify because you can immediately see the effect that different options have
on the data returned by the service.

1. Open Management Console.
2. On the left side of the Management Console, select a service.
3. Click the Preview tab.
4. Enter test input data manually or import data from a file. You do not have to enter data in every field.

You can leave fields blank as necessary.

• To enter data manually, simply type the test data into each field.
• To import test data from a file, click the Import Data button. The maximum number of records you
can import is limited to the maximum number of records your system is configured to process. For
more information, see Limiting the Number of Records to Process on page 67.

If you import date or time data, the type conversion options for date and time data types
will be used to parse the data for previewing.

Note:

5. Click Run Preview. Data will appear in the output grid.
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6. Review your output data, making sure the results are what you intended to get from the service. If
necessary you can make changes to the service's settings and click Run Preview again. (You do
not need to input the data again.)

The default view is vertical. If you wish to change your view to horizontal, click View and select
Horizontal.

Limiting the Number of Records to Process
1. Open Management Console.
2. Click Tools > Options.
3. Click the Run Service Settings tab.
4. In the Maximum number of records to process field, enter the maximum number of records that

a service can process. The maximum number you can enter is 100.

Specifying a Field Separator
A field separator, or delimiter, is the character used to mark the end of one field and the start of another
when you use a flat file as input to a service. To specify the field separator to use for services,

1. Open Management Console.
2. Click Tools > Options.
3. Click the Run Service Settings tab.
4. In the File field separator field, specify the delimiter character to use. If the character you want is

not listed,
a) Click the . . . button.
b) Click Add.
c) After you enter or select a character press Tab. The Unicode field will automatically be completed.

Alternatively, you may enter the unicode value and the Character field will automatically be
completed.

d) If you wish, enter a description of the character in the Description field. For example, if the character
is "&" the description could be "ampersand." If you do not enter a description, the character will
appear by itself in the list of available characters.
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e) Click OK twice.

Setting Service Timeout
1. Open Management Console.
2. Click Tools > Options.
3. Click the Run Service Settings tab.
4. In the Time-out in seconds field, specify the number of seconds to wait for a response before the

service times out.

Optimizing Services
There are a number of different ways to call a Spectrum™ Technology Platform service and some of
them perform better than others. The different ways of calling Spectrum™ Technology Platform services,
in approximate order from fastest to slowest are:

• Client API over SOCKET
• Client API over HTTP
• Client API over HTTPS
• XML over HTTP
• Web Services - SOAP and REST over HTTP

Invoking a service through the client API is generally faster than calling the web service. The network
protocol can have a significant effect on the round-trip time for the service call. For example, using the
persistent SOCKET connection instead of HTTP can improve response time by 30%-50%.

Performance in a real-time application calling Spectrum™ Technology Platform services also depends
on whether the application is single-threaded or multi-threaded, and whether the server has the resources
available to fulfill the service request. For a single-threaded client application, specifying additional
instances of the remote component and/or additional runtime instances of a stage will have minimal
impact on response time. A multi-threaded client application will generally benefit from multiple remote
component instances and runtime instances, up to the number of concurrent threads.

Related Links
Optimizing Database Resources on page 48

Jobs and Process Flows
A job is a dataflow that performs batch processing. A job reads data from one or more files or databases,
processes that data, and writes the output to one or more files or databases.

A process flow executes a series of activities such as Spectrum™ Technology Platform jobs and external
applications. For example, a process flow could run a Spectrum™ Technology Platform job to standardize
names, validate addresses, then invoke an external application to sort the records into the proper
sequence to claim postal discounts.

Use the Management Console to set global job and process flow settings and manage job and process
flow execution. To create or edit jobs and process flows, use Enterprise Designer.

Scheduling Jobs and Process Flows
If you have jobs or process flows that you want to run automatically at a specified time, use the
Management Console to set up job and process flow execution schedules.

1. If you have not already done so, expose the job or process flow.
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You can expose jobs an process flows by opening the job or process flow in Enterprise Designer
and selecting File > Expose/Unexpose and Save.

2. Open the Management Console.
3. Browse to Execution then click Scheduling.
4. Click Add to create a new schedule or, if you want to modify an existing schedule, choose the

schedule and click Modify.
5. In the Add Task or Modify Task window, choose the settings for this task.

• Task Name—The name you want to give to this scheduled task. This is the name that will be
displayed in the task listing.

• Flow type—Choose the type of process you are scheduling, either a job or a process flow.
• Flow name—Select the job or process flow that you want to schedule. Only jobs and process flows
that are saved and exposed are available here. If the job or process flow that you want is not shown,
open the job or process flow in Enterprise Designer then select File > Expose/Unexpose and
Save.

• Enable task—Check this box to run the job or process flow at the specified time. Clear this box
to suspend the schedule.

• Schedule—Specify the date and time you want the job or process flow to run.

6. If the dataflow uses files for input or output, those files must reside on the Spectrum™ Technology
Platform server or on a file server defined as an external resource in Management Console. This
applies both to jobs as well as job activities within a process flow. If a source or sink stage references
a file on a client-only computer, perform one of the following procedures:

DescriptionOption

Move the file to the Spectrum™ Technology Platform server or file server
then modify the dataflow:

Option 1: Modify the
dataflow

1. Open the dataflow in Enterprise Designer.
2. Double-click the source or sink stage.
3. In the File name field, click the browse button.
4. Click Remote Machine then select the file you want.

If you are running Enterprise Designer on the same machine
as the Spectrum™ Technology Platform server, it will appear

Note:

that clicking Remote Machine is no different than clicking My
Computer. However, you must select the file using Remote
Machine in order for the system to recognize the file as being
on the Spectrum™ Technology Platform server.

You can override the file references contained in the flow when this
schedule runs.

Option 2: Override the
dataflow file location
when this schedule
runs 1. Click Options.

2. Under Stage file locations select the stage that references a local
file.

3. Click Modify and select the file on the Spectrum™ Technology
Platform server.

7. If you want the job or process flow to run on a recurring schedule, check the Task recurrence check
box then click the Recurrence button and complete the fields.

8. If the dataflow has been configured for email notification, you can specify additional recipients for
the notifications that will be sent when the dataflow runs.
a) Click Options.
b) Under Notification, click Add.
c) Enter the email address you want the notification to be sent to. For example,

me@mycompany.com.
d) Click OK.
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Notification must be configured in Management Console in order for email notifications to
work. In addition, verify that the dataflow has been configured to support notification. To do
this, open the dataflow in Enterprise Designer, select Edit > Notifications.

Note:

9. Click OK.

Using a File Monitor to Trigger a Job or Process Flow
A file monitor triggers a job or process flow when a control file that you create is detected in a monitored
directory. The presence of this control file indicates that all files required by a particular job or process
flow are in place and ready for processing. When the control file appears, the file monitor runs the job
or process flow you specify. File monitors are useful in cases where there are other processes that create
the files you want to use as inputs to a job or process flow.

1. Open the Management Console.
2. Browse to Execution then click File Monitor.
3. Click Add.
4. In the Task name field, specify a name you wish to give to this monitor. The name can be anything

you choose.
5. Check the Enable task box to turn on this file monitor. Clear the check box to disable this file monitor.
6. In the Flow type field, select the type of flow you want this monitor to run:

Runs a batch job dataflow.Job

Runs a process flow.Process flow

7. In the Flow name field, select the flow you want this monitor to run.
8. If the dataflow has been configured for email notification, you can specify additional recipients for

the notifications that will be sent when the dataflow runs.
a) Click Options.
b) Under Notification, click Add.
c) Enter the email address you want the notification to be sent to. For example,

me@mycompany.com.
d) Click OK.

Notification must be configured in Management Console in order for email notifications to
work. In addition, verify that the dataflow has been configured to support notification. To do
this, open the dataflow in Enterprise Designer, select Edit > Notifications.

Note:

9. In the File field, specify the full path and name of the control file that will trigger the dataflow. You
can specify an exact file name or you can use the asterisk (*) as a wild card. For example, *.trg would
trigger the dataflow when any file with a .trg extension appears in the folder.

The presence of a control file is what triggers a job or process flow to run; it indicates that all files
required for a particular job or process flow are in place and ready to be used in the flow.

The control file can simply be a blank file; its presence alone will trigger the job or dataflow to run.
However, for jobs, the control file can specify overrides to file paths configured in the Write to File or
Read from File stages. To use a control file to override the file paths, specify the Read from File or
Write from File stage names along with the input or output file as the last arguments like this:

stagename=filename

For example:

Read\ from\ File=file:C:/myfile_input.txt
Write\ to\ File=file:C:/myfile_output.txt
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The stage name specified in the control file must match the stage label shown under the stage's icon
in the dataflow. For example, if the input stage is labeled "Read From File" you would specify:

Read\ From\ File=file:C:/inputfile.txt

If the input stage is labeled "Illinois Customers" you would specify:

Illinois\ Customers=file:C:/inputfile.txt

When overriding a Read from File or Write to File location be sure to follow these protocols:

• Start the path with the "file:" protocol. For example, on Windows specify "file:C:/myfile.txt"
and on Unix or Linux specify "file:/testfiles/myfile.txt".

• Contents of this file must be written in plain text. Specifically, the contents must use an ASCII-based
ISO-8559-1 (Latin-1) compatible character encoding.

• You must use forward slashes (/) in file paths, not backslahes.
• Spaces in stage names need to be escaped with a backslash.
• Stage names are case sensitive.

If multiple file monitors are configured, it is important that they each monitor unique file sets.
Otherwise, the same control file may trigger multiple jobs or process flows causing unexpected

Note:

behavior. For organizational purposes we recommend putting all required files and the control
file in a dedicated directory.

10. In the Poll interval field, specify in seconds how often the monitor should look in the designated
location for the control file. For example, if you specify 10 and a file name of AddressData.trg,
the monitor will look every 10 seconds to see if AddressData.trg appears in the monitor folder.

The default is 60 seconds.

11. Under Working folder, in the Folder field, specify the name of the folder in which to place the control
file before running the dataflow. This prevents the flow from being kicked off a second time.

12. In theUpon completion field, specify what to do with the files in the working folder when the dataflow
finishes running.

Leaves the files in their current location with their current name. If you select
this option, the files in the working folder may be overwritten each time the
file monitor runs.

Keep

Moves the files from the working folder to a folder you specify.Move to

Adds a time stamp to the file name in the working folder. This is the simplest
way to preserve a copy of the files in the working folder for monitors that run

Rename with time
stamp

repeatedly, since the renamed folder will have a unique name and so will not
be overwritten the next time the monitor runs a dataflow.

Deletes the files from the working folder after the dataflow finishes running.Delete

13. Click OK when you are done specifying the folders to monitor.

Viewing Execution Status and History
You can view a history of jobs and process flows in Management Console. Execution history displays
information such as when dataflows and process flows ran, whether they were successful, and the
number of records processed.

1. Open Management Console.
2. Expand Execution then click History.
3. Click the Jobs tab to view the history of job execution. Click the Process Flows tab to view the

history of process flow execution.

The Jobs tab is used to monitor job status and to pause, resume, or cancel jobs that are running as
well as delete completed jobs. The Jobs tab displays the ID number, report number, job name, user,
dates, job status, number of records processed, the number of records succeeded, failed, and
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malformed, and any comments returned from the server in a grid format. This information is collected
automatically. Note the following:

• The Succeeded column shows the number of records that have an empty value in the Status field
going to all sinks.

• The Failed column shows the number of records that have a value of F in the Status field going
to all sinks.

• The Malformed column shows the number of records coming out of all source stage error ports.

The Process Flows tab is used to monitor process flow status and to cancel process flows that are
running as well as delete completed process flows. The Process Flows tab displays the ProcessID
number, the ProcessFlowID name, the name of the user who started the process flow, the status of
the process flow, times when the process flow started and ended, and any comments returned from
the server in a grid format. This information is collected automatically. If you click the plus sign next
to any given process flow, you will view Activity Status information for the process flow. The following
information is included in this area:

• ActivityName—includes the names of all activities, including any success activities, that make up
the process flow

• State—the status of the activity (whether it has completed or not)
• ReturnCode—any codes that were returned when the activity ran
• Started—the date and time the activity started
• Finished—the date and time the activity ended
• Comment—any comments associated with the activity

4. Select the fields you want displayed in the Execution History by clicking the icon just to the left of the
first column.

This is the Field Chooser.

5. You can group types of information together in the Execution History. Simply highlight a column name
(such as ID or Name) and drag it up to the area that says, "Drag a column header here to group by
that column." The information will then be grouped by that type of information. For instance, if you
group by name, your Execution History might look like the following:
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6. You can sort the data in the grid by clicking the column name. Filter the data to change the list of
process flows shown by doing the following:
a) Click on the drop-down list next to Show only process flows where to select a variable (such as

ProcessID).
b) Select one of the criterion in the next drop-down (such as "greater than or equal to").
c) Type in a comparison value (such as zero) in the last box.
d) Click Refresh to refresh the data.

7. The Details screen allows you to view the job definition or the process flow definition, which shows
the dataflow. It also allows you to see how a dataflow was built if it's no longer accessible by Enterprise
Designer.
a) Click the job or process flow you wish to view then click Details....

The left pane displays the name of the job or process flow you selected and allows you to select
to see the Execution Information or the flow definition. Within the Execution Information, you can
select any activity within the process flow.

b) Click Job/Process Flow Definition on the left pane to review the processing selections for that
flow.

Pausing and Resuming a Job
To pause and resume a job that is running:

1. Open Management Console.
2. Expand Execution then click History.
3. Click the Jobs tab.
4. Select the job you want to pause then click Pause.
5. To resume job execution, click Resume.

Canceling a Job or Process Flow
1. Open Management Console.
2. Expand Execution then click History.
3. Click the Jobs tab.
4. Select the job you want to cancel then click Cancel.

Exporting Execution History
You can export the information displayed in the Execution History window in Management Console to
an Excel file.

1. Open Management Console.
2. Expand Execution then click History.
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3. Click the Jobs tab if you want to export execution history for jobs. Click Process Flows if you want
to export execution history for process flows.

4. Click Export and choose a location to save the exported file.

If you want to export only certain records, modify the filter settings to show only those jobs or
process flows whose history you want to export.

Tip:

Setting the Default Malformed Records Threshold
You can specify how many malformed records to allow before a job stops processing. For example, if
you specify 50, jobs containing 50 or more malformed records will not complete processing successfully.

This procedure describes how to set a default malformed record threshold for jobs on your system.

You can override the default malformed record threshold for a job by opening the job in Enterprise
Designer and going to Edit > Job Options.

Note:

1. Open Management Console.
2. Expand Execution then click Job Options.
3. Select one of the following:

• Do not terminate the job on a malformed input record—Select this option to allow an unlimited
number of malformed records in a job.

• Terminate the job after reading _ malformed records—Select this option to terminate jobs if a
certain number of malformed records are encountered. Enter the number of malformed records
after which you want a job to stop processing.

Setting Default Report Options
If a job includes a report stage the job generates a report file as specified in the dataflow. Reports can
include processing summaries or postal forms such as the USPSCASS 3553 form. Somemodules come
with predefined reports. You can also create custom reports.

You can set the default report options for your system in Management Console. The default report options
for your system can be overridden. In Enterprise Designer, you can override the options for a particular
job, or for a particular report within a job.

The following procedure describes how to set the default reporting options for your system.

1. Open Management Console.
2. Expand Execution then click Report Options.
3. Select the format to use for reports by selecting html, pdf, or txt.
4. Check the Store report snapshot box to have the system store information indicating that a report

was registered as well as the actual report snapshot.
5. Check theArchive reports box if you wish to save report snapshots. In theReport archive location

field, specify the location where you want to keep the archived reports.
6. Check Overwrite existing reports if you want new reports to replace previous reports.
7. Complete the naming template to reflect how you want to name your reports.

Transaction History
The Transaction History contains data on service usage for the date range you specify. Data is
summarized and sorted by service and by user.
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Viewing Transaction History
1. Open the Management Console.
2. Expand Transaction History then click Report.
3. Select a date range for your report. You can select from the following options:

• All dates—includes a history report for all transactions.
• Dates before and including—includes transactions up to a certain date when you enter an end
date

• Dates after and including—includes transactions after a certain date when you enter a start date
• Dates between—includes transactions between two dates when you enter both a start date and
an end date.

4. Click View Report to run and view the report. The transaction history report for the date range you
specified is displayed. This report shows successes, failures, and errors for calls to each service by
service and by user.

5. Click the Export button if you wish to save the report to an external file.

Setting Transaction History Options
1. Open the Management Console.
2. Expand Transaction History then click Options.
3. Check the Enable transaction history tracking check box to turn on this option. All subsequent

transactions with the service(s) and server will be recorded.
4. If you want to delete transactions from the log, click the drop-down box next to Clear all transaction

log entries occurred on or before and enter a date (MM/DD/YYYY) or select a date from the
calendar that appears below.

5. Click Clear to delete the transactions.

Remote Servers
If you have multiple servers running Spectrum™ Technology Platform you can distribute processing
among the servers by routing the processing for a given service to another server. This feature enables
users to access services available on non-local servers, reducing time for installation and maintenance
of those services. It also allows users to design custom dataflows that include services installed on
remote servers. When a service is routed to another server, the execution of the service will take place
on the remote server, whether the services is within a dataflow, executed from Interactive Driver, or
called using the Spectrum™ Technology Platform API.

To determine if a service is eligible for routing, open the Management Console, click that service, and
see if the Routing button at the bottom of the Options tab is enabled.

A real-time license is required on the remote machine to execute batch dataflows on remote
server modules.

Note:

Tools deployed with a particular product are available only on the machine where that product is physically
installed. For example, if the Enterprise Geocoding Module is installed on both local and remote servers,
the tools for that module will display only for the local server version. If you are running the Enterprise
Geocoding Module only on a remote server, tools will not display at all.

Adding a Remote Server
Follow the steps below to add a remote server.

1. Install Spectrum™ Technology Platform on another server. This will be the remote server. For
installation instructions, see the Spectrum™ Technology Platform Installation Guide.
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2. Open the Management Console.
3. Under System, select Remote Servers.
4. Click Add.
5. Enter the name of the remote server in the Name field (required).
6. Enter the host name or IP address of the remote server in the Host field (required).
7. Enter the port number in the Port field (required).
8. Enter a valid user name for the remote server in the User name field (required).
9. Enter a valid password for the user name you entered in the Password field (required if the server

requires it).
10. In the Microbatch size field, enter the number of records passed at one time, between 1 and 99

(required). The default is 50. Entering a higher number in this field will speed up input and output but
slow down data transmission.

11. Enter the number of seconds, between 1 and 99, when the connection should time out in the Timeout
field (required). The default is 2.

12. Check the Use Secure Sockets Layer box if the remote server you are trying to connect to is behind
a firewall with only HTTPS access.

13. If you wish to test the connection, click the Test button. If you successfully added a remote server,
you will receive a message that says, "Remote server connection test successful."

If the remote server test fails, you will receive a message that says, "Remote server test failed," along
with the reason for the failure.

If the remote server test takes longer than you would like to wait to test (which implies that the test
will fail), you have the option of clicking the Stop button.

14. Click OK.
15. Click Refresh after adding or deleting a service on a remote server to update Management Console.

(Conversely, when you add, modify, or delete a remote server, Management Console will refresh
automatically.)

Related Links
Remote Servers on page 75
Troubleshooting Remote Server Errors on page 77

Routing a Service to a Remote Server
The Routing button enables you to specify a different server to use for a stage or service's processing,
reducing time for installation and maintenance of those services. It also allows you to design custom
dataflows that include services and stages installed on remote servers.

You can override a service's remote server setting in Enterprise Designer or the Spectrum™

Technology Platform API. Remote server routing cannot be overridden in Interactive Driver;
Note:

instead, Interactive Driver will use the remote server routing that is designated in Management
Console.

Follow the steps below to route a service or stage through a remote server:

1. Open the Management Console.
2. Select the service you want to route to a remote server.
3. On the Options tab, click Routing. If the Routing button is grayed out then routing is not available

for this module. The Routing dialog appears.
4. Click Remote and select the remote server to which you wish to route the process for this stage.
5. Click OK.

When you add a remote server that contains services or stages not also available on a local server, it
brings with it the default options from that remote server.

When you make changes to services or stages on a remote Management Console, those changes will
not be reflected on the local server. The local Management Console will reflect its own default options.
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Related Links
Remote Servers on page 75
Troubleshooting Remote Server Errors on page 77

Modifying a Remote Server
Follow the steps below to modify a remote server.

1. Open Management Console.
2. Under System, select the Remote Servers subnode. The Remote Servers dialog box will appear.
3. Highlight the server you want to update and click Modify. The Modify Remote Server dialog box

will appear.
4. Make the appropriate changes to the server and click OK.
5. Click Refresh after adding or deleting a module on a remote server to update Management Console.

(Conversely, when you add, modify, or delete a remote server, Management Console will refresh
automatically.)

Deleting a Remote Server
Follow the steps below to delete a connection.

If someone else is using a dependent dataflow, you will not be able to delete the remote server.Note:

1. Open Management Console.
2. Under System, select the Remote Servers subnode. The Remote Servers dialog box will appear.
3. Highlight the server you want to update and click Delete.
4. You will receive a confirmation message asking if you wish to delete the server. Click OK to confirm.
5. Click Refresh after adding or deleting a module on a remote server to update Management Console.

(Conversely, when you add, modify, or delete a remote server, Management Console will refresh
automatically.)

6. Deleting a remote server will cause any dataflows referencing that remote server to no longer function
properly. If you delete a remote server that has a service or stage routed through it, you are prompted
to change the routing of that service or stage.

• To prevent affected services, stages, and dataflows from becoming unusable, reconfigure the order
of servers, in order of preference, that you wish to replace the server being deleted and click Next.

• The Verify Dataflow References dialog will appear if you have any dataflows that use the remote
server you are deleting.

• The Verify Service References dialog will appear if you have any services or stages that use the
remote server you are deleting.

• Review the information on these dialogs and change the server that the dataflows or services used.
Click Finish.

Troubleshooting Remote Server Errors
This section discusses possible errors you may experience when using remote servers.

Module Not Licensed

The remote server must have a realtime license for the module to execute remote server requests. If
you try to run a job but the remote server does not have a realtime license for the module, you will receive
an error similar to the following:

StageException: No license for stage GetCandidateAddresses on remote server
myremoteserver. A realtime license is required.
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Remote Server Not Available

If the remote server is not running or is not reachable for any other reason, the remote services will
become unavailable in Enterprise Designer and Management Console. You will see a yellow hazard
icon in the status bar at the bottom of the screen:

Click this icon to see an error message that describes which remote servers are not available.

In addition, in Enterprise Designer any stages that use a remote stage will be replaced with an icon
showing you the stage is no longer available:

Routing Has Changed

If you delete or undeploy a service that is installed both locally and remotely and has been routed through
a remote server, and then click that service within Management Console, you will see a routing change
indicator (a blinking exclamation point) next to the routing button on the Options tab for that service. This
indicator means the routing has changed for that service.

Related Links
Remote Servers on page 75
Adding a Remote Server on page 75
Routing a Service to a Remote Server on page 76

Optimizing Sort Performance
Sort Performance options enable you to optimize the performance of sorting operations on large data
sets. The sort performance values you specify in the Management Console can be overridden in individual
stages that perform sorting operations on data.

To specify sort performance settings:

1. Open the Management Console.
2. Expand Execution then click Sort Performance.
3. Use these settings to control sort performance:

Specifies the maximum number of data rows a sorter will hold in
memory before it starts paging to disk. Be careful in environments

In memory record limit

where there are jobs running concurrently because increasing the
In memory record limit setting increases the likelihood of running
out of memory.

Specifies the maximum number of temporary files that may be used
by a sort process.

Maximum number of
temporary files to use

Specifies that temporary files are compressed when they are written
to disk.

Enable compression
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The optimal sort performance settings depends on your server's hardware configuration.
Nevertheless, the following equation generally produces good sort performance:

(InMemoryRecordLimit × MaxNumberOfTempFiles ÷ 2) >=
TotalNumberOfRecords

Note:

Setting Default Type Conversion Options
Spectrum™ Technology Platform automatically converts data to the data type needed by each stage in
a dataflow. In addition, you can convert data between string and numeric or date/time data types in some
stages, such as Read from File. By default, dataflows use the default data type conversion options
specified in the Management Console when a data type conversion fails. You can override the default
behavior for individual dataflows in Enterprise Designer if needed.

To set the default type conversion options for your system, follow this procedure.

1. Open the Management Console.
2. Browse to Execution and click Type Conversion Options.
3. Choose how to handle data type conversion options by selecting one of the following options. These

options specify what to do when Spectrum™ Technology Platform is unable to convert a field's data
to the data type required by a stage.

If a field cannot be converted the dataflow will fail.Fail the dataflow

If a field cannot be converted the record will fail but the dataflow will
continue to run.

Fail the record

If a field cannot be converted the field's value is replaced with the
value you specify here. This option is useful if you know that some

Initialize the field using
default values

records contain bad data and you want to replace the bad data with
a default value. Specify a value for each data type.

4. Specify the formats that you want to use for date and time data that is converted to a string. When
the data or time is converted to a string, the string will be in the format you specify here.
a) In the Locale field, select the country whose format you want to use for dates converted to a

string. Your selection will determine the default values in the Date, Time, and DateTime fields.
Your selection will also determine the language used when a month is spelled out. For example,
if you specify English the first month of the year would be "January" but if you specify French it
would be "Janvier."

b) In the Date field, select the format to use for date data when it is converted to a string. A list of
the most commonly used formats for the selected locale is provided.

For example, if you choose the format M/D/YY and a date field contains 2012-3-2, that date data
would be converted to the string 3/2/12.

c) In the Time field, select the format to use for time data when it is converted to a string. A list of
the most commonly used formats for the selected locale is provided.

For example, if you choose the format h:mm a and a time field contains 23:00, that time data
would be converted to the string 11:00 PM.

d) In the DateTime field, select the format to use for fields containing the DateTime data type when
converted to a string. A list of the most commonly used formats for the selected locale is provided.

For example, if you choose the format M/d/yy h:mm a and a DateTime field contains 2012-3-2
23:00, that DateTime data would be converted to the string 3/2/12 11:00 PM.

e) In the Whole numbers field, select the formatting you want to use for whole numbers (data types
float and double).

For example, if you choose the format #,### then the number 4324 would be formatted as 4,324.
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If you leave this field blank, numbers will be formatted in the same way they were in
Spectrum™ Technology Platform 8.0 and earlier. Specifically, no thousands separator is

Note:

used, the dot (".") is used as the decimal separator, numbers less than 10-3 or greater
than or equal to 107 are shown in scientific notation, and negative numbers have a minus
sign ("-") in front of them. Also note that if you leave this field blank, numbers that use the
bigdecimal data type will always be in the format #,###.000.

f) In the Decimal numbers field, select the formatting you want to use for numbers that contain a
decimal value (data types integer and long).

For example, if you choose the format #,##0.0# then the number 4324.25 would be formatted as
4,324.25.

If you leave this field blank, numbers will be formatted in the same way they were in
Spectrum™ Technology Platform 8.0 and earlier. Specifically, no thousands separator is

Note:

used, the dot (".") is used as the decimal separator, numbers less than 10-3 or greater
than or equal to 107 are shown in scientific notation, and negative numbers have a minus
sign ("-") in front of them. Also note that if you leave this field blank, numbers that use the
bigdecimal data type will always be in the format #,###.000.

You can also specify your own date, time, and number formats if the ones available for selection do
not meet your needs. To specify your own date or time format, type the format into the field using
the notation described in Date and Time Patterns on page 80. To specify your own number format,
type the format into the file using the notation described in Number Patterns on page 82.

Date and Time Patterns
When defining data type options for date and time data, you can create your own custom date or time
pattern if the predefined ones do not meet your needs. To create a date or time pattern, use the notation
described in the following table. For example, this pattern:

dd MMMM yyyy

Would produce a date like this:

14 December 2012

ExampleDescriptionLetter

ADEra designatorG

96Two-digit yearyy

1996Four-digit yearyyyy

7Numeric month of the year.M

07Numeric month of the year. If the number is less
than 10 a zero is added to make it a two-digit
number.

MM

JulShort name of the monthMMM

JulyLong name of the monthMMMM

27Week of the yearw

06Two-digit week of the year. If the week is less than
10 an extra zero is added.

ww

2Week of the monthW

189Day of the yearD
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ExampleDescriptionLetter

006Three-digit day of the year. If the number contains
less than three digits, zeros are added.

DDD

10Day of the monthd

09Two-digit day of the month. Numbers less than 10
have a zero added.

dd

2Day of the week in monthF

TueShort name of the day of the weekE

TuesdayLong name of the day of the weekEEEE

PMAM/PM markera

0Hour of the day, with the first hour being 0 and the
last hour being 23.

H

08Two-digit hour of the day, with the first hour being
0 and the last hour being 23. Numbers less than
10 have a zero added.

HH

24Hour of the day, with the first hour being 1 and the
last hour being 24.

k

02Two-digit hour of the day, with the first hour being
1 and the last hour being 24. Numbers less than
10 have a zero added.

kk

0Hour hour of the morning (AM) or afternoon (PM),
with 0 being the first hour and 11 being the last
hour.

K

02Two-digit hour of the day, with the first hour being
1 and the last hour being 24. Numbers less than
10 have a zero added.

KK

12Hour of the morning (AM) or afternoon (PM), with
1 being the first hour and 12 being the last hour.

h

09Two-digit hour of the morning (AM) or afternoon
(PM), with 1 being the first hour and 12 being the
last hour. Numbers less than 10 have a zero added.

hh

30Minute of the hourm

05Two-digit minutes of the hour. Numbers less than
10 have a zero added.

mm

55Second of the minutes

02Two-digit second of the minute. Numbers less than
10 have a zero added.

ss

978Millisecond of the secondS

978
078
008

Three-digit millisecond of the second. Numbers
containing fewer than three digits will have one or
two zeros added to make them three digits.

SSS

PST
GMT-08:00

Time abbreviation of the time zone name. If the
time zone does not have a name, the GMT offset.

z
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ExampleDescriptionLetter

Pacific Standard Time
GMT-08:00

The full time zone name. If the time zone does not
have a name, the GMT offset.

zzzz

-0800The RFC 822 time zone.Z

-08ZThe ISO 8601 time zone.X

-0800ZThe ISO 8601 time zone with minutes.XX

-08:00ZThe ISO 8601 time zone with minutes and a colon
separator between hours and minutes.

XXX

Related Links
Setting Default Type Conversion Options on page 79

Number Patterns
When defining data type options for numeric data, you can create your own custom number pattern if
the predefined ones do not meet your needs. A basic number pattern consists of the following elements:

• A prefix such as a currency symbol (optional)
• A pattern of numbers containing an optional grouping character (for example a comma as a thousands
separator)

• A suffix (optional)

For example, this pattern:

$ ###,###.00

Would produce a number formatted like this (note the use of a thousands separator after the first three
digits):

$232,998.60

Patterns for Negative Numbers

By default, negative numbers are formatted the same as positive numbers but have the negative sign
added as a prefix. The character used for the number sign is based on the locale. The negative sign is
"-" in most locales. For example, if you specify this number pattern:

0.00

The number negative ten would be formatted like this in most locales:

-10.00

However, if you want to define a different prefix or suffix to use for negative numbers, specify a second
pattern, separating it from the first pattern with a semicolon (";"). For example:

0.00;(0.00)

In this pattern, negative numbers would be contained in parentheses:

(10.00)

Scientific Notation

If you want to format a number into scientific notation, use the character E followed by the minimum
number of digits you want to include in the exponent. For example, given this pattern:

0.###E0

The number 1234 would be formatted like this:
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1.234E3

In other words, 1.234 x 103.

Note the following:

• The number of digit characters after the exponent character gives the minimum exponent digit count.
There is no maximum.

• Negative exponents are formatted using the localized minus sign, not the prefix and suffix from the
pattern.

• Scientific notation patterns cannot contain grouping separators (for example, a thousands separator).

Special Number Pattern Characters

The following characters are used to produce other characters, as opposed to being reproduced literally
in the resulting number. If you want to use any of these special charters as literal characters in your
number pattern's prefix or suffix, surround the special character with quotes.

DescriptionSymbol

Represents a digit in the pattern including zeros where needed to fill in
the pattern. For example, the number twenty-seven when applied to
this pattern:

0

0000

Would be:

0027

Represents a digit but zeros are omitted. For example, the number
twenty-seven when applied to this pattern:

#

####

Would be:

27

The decimal separator or monetary decimal separator used in the
selected locale. For example, in the U.S. the dot (.) is used as the

.

decimal separator but in France the comma (,) is used as the decimal
separator.

The negative sign used in the selected locale. For most locals this is
the minus sign (-).

-

The grouping character used in the selected locale. The appropriate
character for the selected locale will be used. For example, in the U.S.,
the comma (,) is used as a separator.

,

The grouping separator is commonly used for thousands, but in some
countries it separates ten-thousands. The grouping size is a constant
number of digits between the grouping characters, such as 3 for
100,000,000 or 4 for 1,0000,0000. If you supply a pattern with multiple
grouping characters, the interval between the last one and the end of
the integer is the one that is used. For example, all the following patterns
produce the same result:

#,##,###,####

######,####

##,####,####
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DescriptionSymbol

Separates mantissa and exponent in scientific notation. You do not need
to surround the E with quotes in your pattern. See Scientific Notation
on page 82.

E

Separates positive and negative subpatterns. SeePatterns for Negative
Numbers on page 82.

;

Multiply the number by 100 and show the number as a percentage. For
example, the number .35 when applied to this pattern:

%

##%

Would produce this result:

35%

The currency symbol for the selected locale. If doubled, the international
currency symbol is used. If present in a pattern, the monetary decimal
separator is used instead of the decimal separator.

¤

Used to quote special characters in a prefix or suffix. For example:'

"'#'#"

Formats 123 to:

"#123"

To create a single quote itself, use two in a row:

"# o''clock"

Related Links
Setting Default Type Conversion Options on page 79

Configuring Remote Component Options
Some remote components can be configured tomaximize performance. For example, a remote component
might have options controlling how much reference data is cached in memory or how incoming data is
matched to the reference data. Additionally, because a remote component runs in a separate JVM, that
JVM can be configured for performance without affecting the Spectrum™ Technology Platform server.

Remote component options affect all instances of the component as well as any stages that use that
component. This is different from stage options, which can be modified at design time and at runtime.

Universal Addressing Module Component Configuration

For U.S. address processing, there are several options controlling which reference data is cached in
memory. These options are set in this configuration file: server/modules/c1p/java.properties.

• DpvMemoryModel: Controls which DPV files are in memory
• LacsLinkMemoryModel: Controls which LACSLink files are in memory
• SuiteLinkMemoryModel: Controls which SuiteLink files are in memory

Refer to the java.properties configuration file for specifics on the different values for these options.

Spectrum™ Technology Platform 9.084

Configuring Remote Component Options



Enterprise Geocoding Module Component Configuration

The Enterprise Geocoding Module has several options that can affect the performance of U.S. geocoding.
The options are in this configuration file: server/modules/geostan/java.properties. Of particular
interest are:

• egm.us.multimatch.max.records: Specifies the maximum number of possible matches to return. A
smaller number results in better performance, but at the expense of matches.

• egm.us.multimatch.max.processing: Specifies the number of searches to perform. A smaller number
results in better performance, but at the expense of matches.

• FileMemoryLimit: Controls how much of the reference data is initially loaded into memory.

JVM Performance Tuning
There are JVM options that will yield performance gains with certain hardware. These are advanced
options and can cause unexpected behavior when used incorrectly (possibly even JVM crashes). We
recommend that you contact technical support if you want to explore increasing performance by tuning
the JVM.

• On multiple CPU computers the -XX:+UseParallelGC option can be added to improve GC
processing.

• We have also seen performance increases by adding these options, although on some hardware they
have been known to cause JVM crashes.

• -Xmn512m
• -XX:+AggressiveOpts
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Monitoring Performance
The Spectrum™ Technology Platform JMX console provides a performance monitoring tool that records
performance statistics for each stage in a dataflow. Use the JMX console to identify bottlenecks and
observe the effects of different performance tuning adjustments.

1. Open a web browser and go to http://<server>:<port>/jmx-console

Where:

<server> is the IP address or hostname of your Spectrum™ Technology Platform server.

<port> is the HTTP port used by Spectrum™ Technology Platform. The default is 8080.

2. Enter "admin" for both the user name and password.
3. Under " Domain: com.pb.spectrum.platform.performance", click

com.pb.spectrumplatform.performance:server=PerformanceMonitorManager.
4. Click the Invoke button next to enable.
5. Click Return to MBean View to go back to the PerformanceMonitorManager screen.

Performance monitoring is now enabled. When a dataflow runs, the performance statistics will display
at the top of the PerformanceMonitorManager screen.

Note the following:

• The statistics are reported in a semicolon-delimited format. The first row is the column header. We
recommend putting the data into a spreadsheet for easier viewing.

• The time values in the report (Avg, Min, Max, Total) are displayed in milliseconds.
• You must refresh the screen to see updates.
• To reset the counters, click the Invoke button next to reset.
• If you stop the Spectrum™ Technology Platform server, performance monitoring will be turned off. You
will have to turn it back on when you start the server again.
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Configuring E-mail Notification
Spectrum™ Technology Platform can alert you to potential problems to ensure that critical business
processes are not interrupted. Notifications are sent as a result of conditions within dataflows and process
flows. The messages can be formatted to contain context-sensitive information about the event that
occurred.

1. Open the Management Console.
2. Expand System then click Notification.
3. In the Host field, enter a valid host name or IP address.
4. Enter a valid port number or range in the Port field. The default is 25.
5. Enter the user name for logging on to the SMTP server in the User Name field.
6. Enter a password for logging on to the SMTP server in the Password field.
7. If you completed the Password field, re-enter the password for logging on to the SMTP server in the

Confirm Password field.
8. Enter a valid e-mail address to where notification e-mail will be sent in the From Address field.
9. Enter a valid e-mail address to where notification e-mail will be sent in the Test Address field. This

is used to ensure the notification process works.
10. Click Test to send a test message.

Configuring License Expiration Notification
You can have Spectrum™ Technology Platform send an email notification when a license is about to
expire.

1. Open the Management Console.
2. Expand System then click Notification.
3. In the Host field, enter a valid host name or IP address.
4. Enter a valid port number or range in the Port field. The default is 25.
5. Enter the user name for logging on to the SMTP server in the User Name field.
6. Enter a password for logging on to the SMTP server in the Password field.
7. If you completed the Password field, re-enter the password for logging on to the SMTP server in the

Confirm Password field.
8. Enter a valid e-mail address to where notification e-mail will be sent in the From Address field.
9. Enter a valid e-mail address to where notification e-mail will be sent in the Test Address field. This

is used to ensure the notification process works.
10. Click Test to send a test message.
11. Click the Expiration Settings tab.
12. In the Days before expiration to send notification field, specify the number of days in advance

that you want to be notified of a pending license or data expiration. For example, if you want to be
notified 30 days before a license expires, specify 30.

13. Check the Send expiration notification check box.
14. Click Add and specify the email address you want to receive the notification.
15. Select File > Save.
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Event Log

Viewing the Event Log
The event log displays messages from the Spectrum™ Technology Platform server's wrapper log. The
event log contains information about server operations as well as requests made to services from the
API and through web services. Use the event log when you experience trouble and are looking for
information about possible causes.

1. Open the Management Console.
2. Expand Event Log then click Events.
3. Click Refresh to view the latest entries.
4. Check Show events upon open to automatically load the event log. If you do not check this option

you must click the Refresh button to view the latest information.

You can also view the event log by using a text editor and opening the file
<ServerLocation>\server\app\repository\logs\wrapper.log.

Setting Event Log Options
You can specify the default logging level as well as logging levels for each service on your system. When
you change logging levels the change will not be reflected in the log entries made before the change.

1. Open the Management Console.
2. Expand Event Log then click Options.
3. Click the System default logging level drop-down list to select an event logging level. Event logging

levels include the following:

• Disabled—no event logging enabled.
• Fatal—minimal logging, logs only fatal errors. Fatal errors are those that make the system unusable.
• Error—logs only errors and fatal errors. Errors make a single call unusable, possibly a single
service, but not the whole system. The inability to load a specific service might be an error since
other services would be available.

• Warn—event warnings and errors are logged. Warnings indicate problems that do not stop the
system from working (for example, when loading a service where a parameter has an invalid value,
a warning is issued and the default parameter is used). During the use of a service, if results are
returned but there is a problem, a warning will be logged. An example might be that casing was
set to lower case, but Canadian does not support casing. Results are returned with a warning that
the casing option was ignored.

• Info—logging of high-level system information. This is the most detailed logging level suitable for
production. Info level will typically be used during startup and initialization, providing product and
version information, which services were loaded, etc.

• Debug—a highly detailed level of logging, suitable for debugging problems with the system.
• Trace—the most detailed level of logging, tracing program execution (method entry and exit). It
provides detailed program flow information for debugging.

Each logging level includes the ones above it on the list. In other words, if Warning is selected as
the logging level, errors and fatal errors will also be logged. If Info is selected, informational messages,
warnings, errors, and fatal errors will be logged.

Selecting the most intensive logging level can affect system performance. Therefore, you
should select the least intensive setting that meets your particular logging requirements.

Note:

4. If you want to specify different logging levels for each service choose the logging level you want.
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Viewing Version Information
1. In Management Console, expand System then click Version Information.
2. The Version Information window presents information on the configured services. Expanding the

Server Information, System Information, Service Information, and Component Information folders
will present the corresponding details. This includes versions numbers of the server, the operating
system, the service software, and component versions.

This information is view-only.Note:

Viewing and Exporting License Information
1. Open the Management Console.
2. Expand System then click Licensing.
3. Click the Expiration Info tab to view a list of licenses that are about to expire. Only licenses that are

within the period specified on in the Notification node, Expiration Settings tab, are displayed.
4. Click the License Information tab to view a complete listing of all licenses installed on your system.

To export your license information to a .lic file, click Export. This is helpful when resolving license
issues with technical support.
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What Is Spectrum™ Technology Platform?
Spectrum™ Technology Platform is a system that improves the completeness, validity, consistency,
timeliness, and accuracy of your data through data standardization, verification and enhancement.
Ensuring that your data is accurate, complete, and up to date enables your firm to better understand
and connect with your customers.

For more information on Spectrum™ Technology Platform, please visit the Spectrum™

Technology Platform Video Tutorials site.
Note:

Spectrum™ Technology Platform aids in the design and implementation of business rules for data quality
by performing the following functions.

Parsing, Name Standardization, and Name Validation

To perform the most accurate standardization you may need to break up strings of data into multiple
fields. Spectrum™ Technology Platform provides advanced parsing features that enable you to parse
personal names, company names, and many other terms and abbreviations. In addition, you can create
your own list of custom terms to use as the basis of scan/extract operations. The Universal NameModule
provides this functionality.

Deduplication and Consolidation

Identifying unique entities enables you to consolidate records, eliminate duplicates and develop
"best-of-breed" records. A "best-of-breed" record is a composite record that is built using data from other
records. The Advanced Matching Module and Data Normalization Module provide this functionality.

Address Validation

Address validation applies rules from the appropriate postal authority to put an address into a standard
form and even validate that the address is a deliverable address. Address validation can help you qualify
for postal discounts and can improve the deliverability of your mail. The Universal Addressing Module
and the Address Now Module provide this functionality.

Geocoding

Geocoding is the process of taking an address and determining its geographic coordinates (latitude and
longitude). Geocoding can be used for map generation, but that is only one application. The underlying
location data can help drive business decisions. Reversing the process, you can enter a geocode (a
point represented by a latitude and longitude coordinate) and receive address information about the
geocode. The Enterprise Geocoding Module provides this functionality.

Location Intelligence

Location intelligence creates new information about your data by assessing, evaluating, analyzing and
modeling geographic relationships. Using location intelligence processing you can verify locations and
transform information into valuable business intelligence. The Location Intelligence Module provides this
functionality.

Master Data Management

Master data management enables you to create relationship-centric master data views of your critical
data assets. The Data Hub Module helps you identify influencers and non-obvious relationships, detect
fraud, and improve the quality, integration, and accessibility of your information.
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Tax Jurisdiction Assignment

Tax jurisdiction assignment takes an address and determines the tax jurisdictions that apply to the
address's location. Assigning the most accurate tax jurisdictions can reduce financial risk and regulatory
liability.

Spectrum™ Technology Platform software from Pitney Bowes Software integrates up-to-date jurisdictional
boundaries with the exact street addresses of your customer records, enabling you to append the correct
state, county, township, municipal, and special tax district information to your records. Some example
uses of tax jurisdiction assignment are:

• Sales and use tax
• Personal property tax
• Insurance premium tax

The Enterprise Tax Module provides this functionality.

Enterprise Data Management Architecture
With Spectrum™ Technology Platform, you can build a comprehensive enterprise data management
process, or you can target those individual areas in which your company needs improvement. The
following diagram illustrates a complete solution that takes data from its source, through data enrichment
and data quality processes, feeding a master data management hub which makes a single view of the
data available to multiple business applications.
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Data Discovery

Data discovery is the process of scanning your data resources to get a complete inventory of your data
landscape. Spectrum™ Technology Platform can scan structured data, unstructured data, and
semi-structured data using a wide array of data profiling techniques. The results of the scan are used
to automatically generate a library of documentation describing your company's data assets and to create
a metadata repository. This documentation and accompanying metadata repository provide the insight
you need before beginning data integration, data quality, data governance, or master data management
projects.

For more information on the Spectrum™ Technology Platform Data Discovery Module, contact your
account executive.

Data Integration

Once you have an inventory of your data landscape, you need to consider how you will access the data
you need to manage. Spectrum™ Technology Platform can connect to data in multiple sources either
directly or through integration with your existing data access technologies. It supports batch and real
time data integration capabilities for a variety of business needs including data warehousing, data quality,
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systems integration, and migration. Spectrum™ Technology Platform can access data in RDBMS
databases, data warehouses, XML files, flat files, and variable format files. Spectrum™ Technology
Platform supports SQL queries with complex joins and aggregations and provides a visual query
development tool. In addition, Spectrum™ Technology Platform can access data over REST and SOAP
web services.

Spectrum™ Technology Platform can trigger batch processing based on the appearance of one or more
source files in a specified folder. This "hot folder" trigger is useful for monitoring FTP uploads and
processing them as they occur.

Some of these data integration capabilities require a license for the Enterprise Data Integration Module.
For more information, contact your account executive.

Finally, Spectrum™ Technology Platform can integrate with packaged applications such as SAP and
Siebel.

Data Quality/Governance

Data quality and data governance processes check your data for duplicate records, inconsistent
information, and inaccurate information.

Duplicate matching identifies potential duplicate records or relationships between records, whether the
data is name and address in nature or any other type of customer information. Spectrum™ Technology
Platform allows you to specify a consistent set of business match rules using boolean matching methods,
scoringmethods, thresholds, algorithms and weights to determine if a group of records contains duplicates.
Spectrum™ Technology Platform supports extensive customization so you can tailor the rules to the
unique needs of your business.

Once duplicate records have been identified, youmay wish to consolidate records. Spectrum™ Technology
Platform allows you to specify how to link or merge duplicate records so you can create the most accurate
and complete record from any collection of customer information. For example, a single best-of-breed
record can be built from all of the records in a household. The Advanced Matching Module is used to
identify duplicates and eliminate them.

Data quality processes also standardize your data. Standardization is a critical process because
standardized data elements are necessary to achieve the highest possible results for matching and
identifying relationships between records. While several modules perform standardization of one type
or another, the Spectrum™ Technology Platform Data Normalization module provides the most
comprehensive set of standardization features. In addition, the Universal Namemodule provides specific
data quality features for handling personal name and business name data.

Standardized data is not necessarily accurate data. Spectrum™ Technology Platform can compare your
data to known, up-to-date reference data for correctness. The sources used for this process may include
regulatory bodies such as the U.S. Postal Service, third-party data providers such as Experian or D&B,
or your company's internal reference sources, such as accounting data. Spectrum™ Technology Platform
is particularly strong in address data validation. It can validate or standardize addresses in 250 countries
and territories around the world. There are two modules that perform address validation: the Address
Now Module and the Universal Addressing Module.

To determine which one is right for you, discuss your needs with your account executive.

While Spectrum™ Technology Platform can automatically handle a wide range of data quality issues,
there are some situations where a manual review by a data steward is appropriate. To support this, the
Business Steward Module provides a way to specify the rules that will trigger a manual review, and it
provides a web-based tool for reviewing exception records. It includes integrated access to third-party
tools such as Bing maps and Experian data to aid data stewards in the review and resolution process.

Data Enrichment

Data enrichment processes augment your data with additional information. Enrichment can be based
on spatial data, marketing data, or data from other sources that you wish to use to add additional detail
to your data. For example, if you have a database of customer addresses, you could geocode the address
to determine the latitude/longitude coordinates of the address and store those coordinates as part of the
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record. Your customer data could then be used to perform a variety of spatial calculations, such as
finding the bank branch nearest the customer. Spectrum™ Technology Platform allows you to enrich
your data with a variety of information, including geocoding (with the Enterprise Geocoding Module), tax
jurisdiction assignment (with the Enterprise Tax Module), geospatial calculations (with the Location
Intelligence Module), and driving and walking directions between points (with the Enterprise Routing
Module).

Master Data Management Hub

The Master Data Management (MDM) hub allows for rapid modeling of entities and their complex
relationships across roles, processes and interactions. It provides built-in social network analysis
capabilities to help you understand influencers, predict churn, detect non-obvious relationships and
fraudulent patterns, and provide recommendations.

Spectrum™ Technology Platform supports two approaches to the MDM hub. In the master hub approach,
the data is maintained in a single MDM database and applications access the data from the MDM
database. In the registry approach, the data is maintained in each business application and the MDM
hub registry contains keys which are used to find related records. For example, a customer's record may
exist in an order entry database and a customer support database. The MDM registry would contain a
single key which could be used to access the customer data in both places.

The Data Hub Module provides MDM capabilities.

Spectrum™ Technology Platform Architecture
Spectrum™ Technology Platform software from Pitney Bowes Software includes a server that supports
a number of modules. These modules provide different functions, such as address validation, geocoding,
and advanced parsing, among others. The following diagram illustrates the Spectrum™ Technology
Platform architecture.
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Server

The foundation of the Spectrum™ Technology Platform is the server. The server handles data processing,
synchronizes repository data, and manages communication between the client and the transformation
modules via TCP/IP. It provides job management and security features.

Modules

Modules are sets of features that perform a specific function. For example, if you want to standardize
your customers' addresses to conform to USPS standards, you would license the Universal Addressing
module. If you want to determine the tax jurisdictions that apply to each of your customers, you would
license the Enterprise Tax module. You can license just one module or multiple modules, depending on
your specific needs. Most modules consist of "components" and databases.

Components

A component is a basic building block in a customer data quality process. Each component performs a
specific function. For example, the Enterprise Geocoding module's Geocode US Address component
takes an address and returns the latitude and longitude coordinates for that address; the Universal
Addressing module's Get City State Province takes a postal code and returns the city and state/province
where that postal code is located.

Some components must first be combined with other components into a job, service, or subflow before
they can be executed. Use Enterprise Designer to create jobs, services, subflows, and process flows.
For more information, see Enterprise Designer on page 100.

The components that you have available on your system depend on which Spectrum™ Technology
Platform modules you have licensed from Pitney Bowes Software.
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Databases

Modules often include databases that contain the data needed by the components in the module. For
example, the Universal Addressing module needs to have access to USPS data in order to verify and
standardize addresses. So, the Universal Addressing module comes with the U.S. Postal Database,
which you must load into a location that is accessible by your Spectrum™ Technology Platform system.

Modules have both required and optional databases. Optional databases provide data needed for certain
features that can greatly enhance your Spectrum™ Technology Platform process.

Management Console

The Management Console is a Windows-based tool for administering Spectrum™ Technology Platform.
You can use the Management Console to:

• Specify a server access address
• Select component access method (local or hosted)
• Specify the default settings for Spectrum™ Technology Platform components
• Manage user accounts, including permissions and passwords
• Set up logging, tracking, and reporting.

Enterprise Designer

Enterprise Designer is aWindows-based tool for creating Spectrum™ Technology Platform jobs, services,
subflows, and process flows. It utilizes an easy drag-and-drop interface to allow you to graphically create
complex dataflows.
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API

The Spectrum™ Technology Platform API, which is provided in the Spectrum™ Technology Platform
Client API, is designed to provide simple integration, streamline record processing, and support backward
compatibility of future versions. The Spectrum™ Technology Platform API can be accessed through:

• C
• C++
• COM
• Java
• .NET
• Web services

Modules and Components
Table 2: Modules, Components, and Databases

ComponentsDescriptionModule

Build Global AddressProvides enhanced validation and
standardization for addresses outside the
U.S., and other address processing.

Address Now Module

Get Global Candidate
Addresses

Validate Global Address

Best Of BreedMatches records within and/or between input
files.

Advanced Matching
Module

101Administration Guide

Chapter 7: About Spectrum Technology Platform



ComponentsDescriptionModule

Candidate Finder

Duplicate Synchronization

Filter

Interflow Match

Intraflow Match

Match Key Generator

Transactional Match

Exception MonitorIdentifies exception records and provides a
browser-based tool for manually reviewing
exception records.

Business Steward
Module Read Exceptions

Write Exceptions

Country IdentifierTakes a country name or a combination of
postal code and state/province and returns

Country Identifier

the two-character ISO country code, the
three-character Universal Postal Union (UPU)
code, and the English country name.

Write to HubLinks and analyzes data, identifying
relationships and trends.

Data Hub Module

Read From Hub

Query Hub

Graph Visualization

Field SelectorProvides capabilities useful in data
warehousing, data quality, systems
integration, and migration.

Data Integration Module

Generate Time Dimension

Query Cache

Write to Cache

Advanced TransformerRemoves inconsistencies in data.Data Normalization
Module Open Parser

Table Lookup

Transliterator

Call Stored ProcedureConnects to data in multiple sources for a
variety of business needs including data

Enterprise Data
Integration Field Selectorwarehousing, data quality, systems

integration, and migration. Generate Time Dimension

Query Cache

Write to Cache

Geocode Address AUSDetermines the geographic coordinates for
an address. Also determines the address of
a given latitude and longitude.

Enterprise Geocoding
Module Geocode Address GBR

Geocode Address Global

Geocode Address World

Geocode US Address

GNAF PID Location Search

Reverse APN Lookup

Reverse Geocode Address
Global
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ComponentsDescriptionModule

Reverse Geocode US
Location

Get Travel BoundaryObtains driving or walking directions,
calculates drive time and drive distance, and

Enterprise Routing
Module Get Travel Cost Matrixidentifies locations within a certain time or

distance from a starting point. Get Travel Directions

Assign GeoTAX InfoDetermines the tax jurisdictions that apply to
a given location.

Enterprise Tax Module

Calculate Distance

Geo Confidence SurfaceDetermines the probability that an address or
street intersection is within a given area.

GeoConfidence Module

CreatePointsConvexHull

Global SentryAttempts to match transactions against
government-provided watch lists that contain
data from different countries.

Global Sentry

Global Sentry Address Check

Global Sentry ID Number
Check

Global Sentry Name Check

Global Sentry Other Data
Check

Closest SitePerforms point in polygon and radial analysis
against a variety of geospatial databases.

Location Intelligence
Module Find Nearest

Point In Polygon

Query Spatial Data

Read Spatial Data

Spatial Calculator

Spatial Union

SAP Generate Match KeyEnables Spectrum™ Technology Platform to
interface with SAP Customer Relationship
Management Module applications.

SAP Module

SAP Generate Match Score

SAP Generate Search Key

SAP Generate Search Key
Constant

SAP Generate Search Key
Metaphone

SAP Generate Search Key
Substring

SAP Validate Address With
Candidates

Siebel Generate Match KeyEnables Spectrum™ Technology Platform to
interface Siebel applications.

Siebel Module

Siebel Generate Match Score

Siebel Generate Search Key

Siebel Business Name
Standardization

Siebel Standardize Name

Siebel Geocode US Address
With Candidates
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ComponentsDescriptionModule

Siebel Geocode US Address
With No Candidates

Siebel Get Global Candidate
Addresses

Siebel Validate Address With
Candidates

Siebel Validate Address With
No Candidates

Get Candidate AddressesStandardizes and validates addresses
according to the postal authority's standards.

Universal Addressing
Module Get City State Province

Get Postal Codes

Validate Address

Validate Address AUS

Validate Address Global

Name Parser (Deprecated)Parses personal names, company names,
addresses, and many other terms and
abbreviations.

Universal Name Module

Name Variant Finder

Open Name Parser

Spectrum™ Technology Platform 9.0104

Modules and Components



Appendix

In this section:

• Country ISO Codes and Module Support . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .107





ACountry ISO Codes and
Module Support

In this section:

• Country ISO Codes and Module Support . . . . . . . . . . . .108



Country ISO Codes and Module Support
The following table lists the ISO codes for each country as well as the modules that support addressing,
geocoding, and routing for each country.

Supported ModulesISO 3116-1
Alpha-3

ISO 3116-1
Alpha-2

ISO Country Name (English)

Address Now Module
Universal Addressing Module

AFGAFAfghanistan

Address Now Module
Universal Addressing Module

ALAAXAland Islands

Address Now Module
Universal Addressing Module

ALBALAlbania

Address Now Module
Universal Addressing Module

DZADZAlgeria

Address Now Module
Universal Addressing Module

ASMASAmerican Samoa

Address Now Module
Enterprise Geocoding Module1

Universal Addressing Module

ANDADAndorra

Address Now Module
Enterprise Geocoding Module
Universal Addressing Module

AGOAOAngola

Address Now Module
Universal Addressing Module

AIAAIAnguilla

Address Now Module
Universal Addressing Module

ATAAQAntarctica

Address Now Module
Universal Addressing Module

ATGAGAntigua And Barbuda

Address Now Module
Enterprise Geocoding Module
Universal Addressing Module

ARGARArgentina

Address Now Module
Universal Addressing Module

ARMAMArmenia

Address Now Module
Universal Addressing Module

ABWAWAruba

Address Now Module
Enterprise Geocoding Module

AUSAUAustralia

Enterprise Routing Module
Universal Addressing Module

1 Andorra is covered by the Spain geocoder

Spectrum™ Technology Platform 9.0108

Country ISO Codes and Module Support



Supported ModulesISO 3116-1
Alpha-3

ISO 3116-1
Alpha-2

ISO Country Name (English)

Address Now Module
Enterprise Geocoding Module

AUTATAustria

Enterprise Routing Module
Universal Addressing Module

Address Now Module
Universal Addressing Module

AZEAZAzerbaijan

Address Now Module
Enterprise Geocoding Module
Universal Addressing Module

BHSBSBahamas

Address Now Module
Universal Addressing Module

BHRBHBahrain

Address Now Module
Universal Addressing Module

BGDBDBangladesh

Address Now Module
Universal Addressing Module

BRBBBBarbados

Address Now Module
Universal Addressing Module

BLRBYBelarus

Address Now Module
Enterprise Geocoding Module

BELBEBelgium

Enterprise Routing Module
Universal Addressing Module

Address Now Module
Universal Addressing Module

BLZBZBelize

Address Now Module
Enterprise Geocoding Module
Universal Addressing Module

BENBJBenin

Address Now Module
Universal Addressing Module

BMUBMBermuda

Address Now Module
Universal Addressing Module

BTNBTBhutan

Address Now Module
Universal Addressing Module

BOLBOBolivia, Plurinational State Of

Address Now Module
Universal Addressing Module

BESBQBonaire, Saint Eustatius And
Saba

Address Now Module
Universal Addressing Module

BIHBABosnia And Herzegovina

Address Now Module
Enterprise Geocoding Module
Universal Addressing Module

BWABWBotswana
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Supported ModulesISO 3116-1
Alpha-3

ISO 3116-1
Alpha-2

ISO Country Name (English)

Address Now Module
Universal Addressing Module

BVTBVBouvet Island

Address Now Module
Enterprise Geocoding Module

BRABRBrazil

Enterprise Routing Module
Universal Addressing Module

Address Now Module
Universal Addressing Module

IOTIOBritish Indian Ocean Territory

Address Now Module
Universal Addressing Module

BRNBNBrunei Darussalam

Address Now Module
Universal Addressing Module

BGRBGBulgaria

Address Now Module
Enterprise Geocoding Module
Universal Addressing Module

BFABFBurkina Faso

Address Now Module
Enterprise Geocoding Module
Universal Addressing Module

BDIBIBurundi

Address Now Module
Universal Addressing Module

KHMKHCambodia

Address Now Module
Enterprise Geocoding Module
Universal Addressing Module

CMRCMCameroon

Address Now Module
Enterprise Geocoding Module

CANCACanada

Enterprise Routing Module
Universal Addressing Module

Address Now Module
Universal Addressing Module

CPVCVCape Verde

Address Now Module
Universal Addressing Module

CYMKYCayman Islands

Address Now Module
Universal Addressing Module

CAFCFCentral African Republic

Address Now Module
Universal Addressing Module

TCDTDChad

Address Now Module
Enterprise Geocoding Module
Universal Addressing Module

CHLCLChile
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Supported ModulesISO 3116-1
Alpha-3

ISO 3116-1
Alpha-2

ISO Country Name (English)

Address Now Module
Enterprise Geocoding Module
Universal Addressing Module

CHNCNChina

Address Now Module
Universal Addressing Module

CXRCXChristmas Island

Address Now Module
Universal Addressing Module

CCKCCCocos (Keeling) Islands

Address Now Module
Universal Addressing Module

COLCOColombia

Address Now Module
Universal Addressing Module

COMKMComoros

Address Now Module
Enterprise Geocoding Module
Universal Addressing Module

COGCGCongo

Address Now Module
Enterprise Geocoding Module
Universal Addressing Module

CODCDCongo, The Democratic
Republic Of The

Address Now Module
Universal Addressing Module

COKCKCook Islands

Address Now Module
Universal Addressing Module

CRICRCosta Rica

Address Now Module
Universal Addressing Module

CIVCICôte d'Ivoire

Address Now Module
Enterprise Geocoding Module
Universal Addressing Module

HRVHRCroatia

Address Now Module
Universal Addressing Module

CUBCUCuba

Address Now Module
Universal Addressing Module

CUWCWCuracao

Address Now Module
Universal Addressing Module

CYPCYCyprus

Address Now Module
Enterprise Geocoding Module
Universal Addressing Module

CZECZCzech Republic

Address Now Module
Enterprise Geocoding Module

DNKDKDenmark

Enterprise Routing Module
Universal Addressing Module
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Supported ModulesISO 3116-1
Alpha-3

ISO 3116-1
Alpha-2

ISO Country Name (English)

Address Now Module
Universal Addressing Module

DJIDJDjibouti

Address Now Module
Universal Addressing Module

DMADMDominica

Address Now Module
Universal Addressing Module

DOMDODominican Republic

Address Now Module
Universal Addressing Module

ECUECEcuador

Address Now Module
Universal Addressing Module

EGYEGEgypt

Address Now Module
Universal Addressing Module

SLVSVEl Salvador

Address Now Module
Universal Addressing Module

GNQGQEquatorial Guinea

Address Now Module
Universal Addressing Module

ERIEREritrea

Address Now Module
Enterprise Geocoding Module
Universal Addressing Module

ESTEEEstonia

Address Now Module
Universal Addressing Module

ETHETEthiopia

Address Now Module
Universal Addressing Module

FLKFKFalkland Islands (Malvinas)

Address Now Module
Universal Addressing Module

FROFOFaroe Islands

Address Now Module
Universal Addressing Module

FJIFJFiji

Address Now Module
Enterprise Geocoding Module

FINFIFinland

Enterprise Routing Module
Universal Addressing Module

Address Now Module
Enterprise Geocoding Module

FRAFRFrance

Enterprise Routing Module
Universal Addressing Module

Address Now Module
Enterprise Geocoding Module 2

Universal Addressing Module

GUFGFFrench Guiana

2 French Guiana is covered by the France geocoder
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Supported ModulesISO 3116-1
Alpha-3

ISO 3116-1
Alpha-2

ISO Country Name (English)

Address Now Module
Universal Addressing Module

PYFPFFrench Polynesia

Address Now Module
Universal Addressing Module

ATFTFFrench Southern Territories

Address Now Module
Enterprise Geocoding Module
Universal Addressing Module

GABGAGabon

Address Now Module
Universal Addressing Module

GMBGMGambia

Address Now Module
Universal Addressing Module

GEOGEGeorgia

Address Now Module
Enterprise Geocoding Module

DEUDEGermany

Enterprise Routing Module
Universal Addressing Module

Address Now Module
Enterprise Geocoding Module
Universal Addressing Module

GHAGHGhana

Address Now Module
Enterprise GeocodingModule 3Universal
Addressing Module

GIBGIGibraltar

Address Now Module
Enterprise Geocoding Module
Universal Addressing Module

GRCGRGreece

Address Now Module
Universal Addressing Module

GRLGLGreenland

Address Now Module
Universal Addressing Module

GRDGDGrenada

Address Now Module
Enterprise Geocoding Module 4

Universal Addressing Module

GLPGPGuadeloupe

Address Now Module
Universal Addressing Module

GUMGUGuam

Address Now Module
Universal Addressing Module

GTMGTGuatemala

Address Now Module
Universal Addressing Module

GGYGGGuernsey

3 Gibraltar is covered by the Spain geocoder
4 Guadeloupe is covered by the France geocode
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Supported ModulesISO 3116-1
Alpha-3

ISO 3116-1
Alpha-2

ISO Country Name (English)

Address Now Module
Universal Addressing Module

GINGNGuinea

Address Now Module
Universal Addressing Module

GNBGWGuinea-Bissau

Address Now Module
Universal Addressing Module

GUYGYGuyana

Address Now Module
Universal Addressing Module

HTIHTHaiti

Address Now Module
Universal Addressing Module

HMDHMHeard Island and McDonald
Islands

Address Now Module
Enterprise Geocoding Module 5

Universal Addressing Module

VATVAHoly See (Vatican City State)

Address Now Module
Universal Addressing Module

HNDHNHonduras

Address Now Module
Enterprise Geocoding Module
Universal Addressing Module

HKGHKHong Kong

Address Now Module
Enterprise Geocoding Module
Universal Addressing Module

HUNHUHungary

Address Now Module
Universal Addressing Module

ISLISIceland

Address Now Module
Enterprise Geocoding Module
Universal Addressing Module

INDINIndia

Address Now Module
Enterprise Geocoding Module
Universal Addressing Module

IDNIDIndonesia

Address Now Module
Universal Addressing Module

IRNIRIran, Islamic Republic Of

Address Now Module
Universal Addressing Module

IRQIQIraq

Address Now Module
Enterprise Geocoding Module

IRLIEIreland

Enterprise Routing Module
Universal Addressing Module

5 The Vatican is covered by the Italy geocoder
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Supported ModulesISO 3116-1
Alpha-3

ISO 3116-1
Alpha-2

ISO Country Name (English)

Address Now Module
Universal Addressing Module

IMNIMIsle Of Man

Address Now Module
Universal Addressing Module

ISRILIsrael

Address Now Module
Enterprise Geocoding Module

ITAITItaly

Enterprise Routing Module
Universal Addressing Module

Address Now Module
Universal Addressing Module

JAMJMJamaica

Address Now Module
Enterprise Geocoding Module
Universal Addressing Module

JPNJPJapan

Address Now Module
Universal Addressing Module

JEYJEJersey

Address Now Module
Universal Addressing Module

JORJOJordan

Address Now Module
Universal Addressing Module

KAZKZKazakhstan

Address Now Module
Enterprise Geocoding Module
Universal Addressing Module

KENKEKenya

Address Now Module
Universal Addressing Module

KIRKIKiribati

Address Now Module
Universal Addressing Module

PRKKPKorea, Democratic People's
Republic Of

Address Now Module
Universal Addressing Module

KORKRKorea, Republic Of

Address Now Module
Universal Addressing Module

KOSKSKosovo

Address Now Module
Universal Addressing Module

KWTKWKuwait

Address Now Module
Universal Addressing Module

KGZKGKyrgyzstan

Address Now Module
Universal Addressing Module

LAOLALao People's Democratic
Republic

Address Now Module
Enterprise Geocoding Module
Universal Addressing Module

LVALVLatvia
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Supported ModulesISO 3116-1
Alpha-3

ISO 3116-1
Alpha-2

ISO Country Name (English)

Address Now Module
Universal Addressing Module

LBNLBLebanon

Address Now Module
Enterprise Geocoding Module
Universal Addressing Module

LSOLSLesotho

Address Now Module
Universal Addressing Module

LBRLRLiberia

Address Now Module
Universal Addressing Module

LBYLYLibyan Arab Jamahiriya

Address Now Module
Enterprise Geocoding Module 6

LIELILiechtenstein

Enterprise Routing Module
Universal Addressing Module

Address Now Module
Enterprise Geocoding Module
Universal Addressing Module

LTULTLithuania

Address Now Module
Enterprise Geocoding Module 7

LUXLULuxembourg

Enterprise Routing Module
Universal Addressing Module

Address Now Module
Enterprise Geocoding Module
Universal Addressing Module

MACMOMacao

Address Now Module
Universal Addressing Module

MKDMKMacedonia, Former Yugoslav
Republic Of

Address Now Module
Universal Addressing Module

MDGMGMadagascar

Address Now Module
Universal Addressing Module

MWIMWMalawi

Address Now Module
Enterprise Geocoding Module

MYSMYMalaysia

Enterprise Routing Module
Universal Addressing Module

Address Now Module
Universal Addressing Module

MDVMVMaldives

Address Now Module
Enterprise Geocoding Module
Universal Addressing Module

MLIMLMali

6 Liechtenstein is covered by the Switzerland geocoder
7 Luxembourg is covered by the Belgium geocoder
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Supported ModulesISO 3116-1
Alpha-3

ISO 3116-1
Alpha-2

ISO Country Name (English)

Address Now Module
Universal Addressing Module

MLTMLMalta

Address Now Module
Universal Addressing Module

MHLMHMarshall Islands

Address Now Module
Enterprise Geocoding Module

MTQMQMartinique

Guadeloupe is covered by the France
geocode Universal Addressing Module

Address Now Module
Universal Addressing Module

MRTMRMauritania

Address Now Module
Universal Addressing Module

MUSMUMauritius

Address Now Module
Enterprise Geocoding Module Universal
Addressing Module

MYTYTMayotte

Address Now Module
Enterprise Geocoding Module
Universal Addressing Module

MEXMXMexico

Address Now Module
Universal Addressing Module

FSMFMMicronesia, Federated States
Of

Address Now Module
Universal Addressing Module

MDAMDMoldova, Republic Of

Address Now Module
Enterprise Geocoding Module
10Universal Addressing Module

MCOMCMonaco

Address Now Module
Universal Addressing Module

MNGMNMongolia

Address Now Module
Universal Addressing Module

MNEMEMontenegro

Address Now Module
Universal Addressing Module

MSRMSMontserrat

Address Now Module
Enterprise Geocoding Module
Universal Addressing Module

MARMAMorocco

Address Now Module
Enterprise Geocoding Module
Universal Addressing Module

MOZMZMozambique

8 Martinique is covered by the France geocoder.
9 Mayotte is covered by the France geocoder.
10 Monaco is covered by the France geocoder
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Supported ModulesISO 3116-1
Alpha-3

ISO 3116-1
Alpha-2

ISO Country Name (English)

Address Now Module
Universal Addressing Module

MMRMMMyanmar

Address Now Module
Enterprise Geocoding Module
Universal Addressing Module

NAMNANamibia

Address Now Module
Universal Addressing Module

NRUNRNauru

Address Now Module
Universal Addressing Module

NPLNPNepal

Address Now Module
Enterprise Geocoding Module

NLDNLNetherlands

Enterprise Routing Module
Universal Addressing Module

Address Now Module
Universal Addressing Module

NCLNCNew Caledonia

Address Now Module
Enterprise Geocoding Module

NZLNZNew Zealand

Enterprise Routing Module
Universal Addressing Module

Address Now Module
Universal Addressing Module

NICNINicaragua

Address Now Module
Enterprise Geocoding Module
Universal Addressing Module

NERNENiger

Address Now Module
Enterprise Geocoding Module
Universal Addressing Module

NGANGNigeria

Address Now Module
Universal Addressing Module

NIUNUNiue

Address Now Module
Universal Addressing Module

NFKNFNorfolk Island

Address Now Module
Universal Addressing Module

MNPMPNorthern Mariana Islands

Address Now Module
Enterprise Geocoding Module

NORNONorway

Enterprise Routing Module
Universal Addressing Module

Address Now Module
Universal Addressing Module

OMNOMOman
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Supported ModulesISO 3116-1
Alpha-3

ISO 3116-1
Alpha-2

ISO Country Name (English)

Address Now Module
Universal Addressing Module

PAKPKPakistan

Address Now Module
Universal Addressing Module

PLWPWPalau

Address Now Module
Universal Addressing Module

PSEPSPalestinian Territory,
Occupied

Address Now Module
Universal Addressing Module

PANPAPanama

Address Now Module
Universal Addressing Module

PNGPGPapua New Guinea

Address Now Module
Universal Addressing Module

PRYPYParaguay

Address Now Module
Universal Addressing Module

PERPEPeru

Address Now Module
Enterprise Geocoding Module
Universal Addressing Module

PHLPHPhilippines

Address Now Module
Universal Addressing Module

PCNPNPitcairn

Address Now Module
Enterprise Geocoding Module

POLPLPoland

Enterprise Routing Module
Universal Addressing Module

Address Now Module
Enterprise Geocoding Module

PRTPTPortugal

Enterprise Routing Module
Universal Addressing Module

Address Now Module
Universal Addressing Module

PRIPRPuerto Rico

Address Now Module
Universal Addressing Module

QATQAQatar

Address Now Module
Enterprise Geocoding Module
11Universal Addressing Module

REUREReunion

Address Now Module
Universal Addressing Module

ROURORomania

11 Reunion is covered by the France geocoder
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Supported ModulesISO 3116-1
Alpha-3

ISO 3116-1
Alpha-2

ISO Country Name (English)

Address Now Module
Enterprise Geocoding Module
Universal Addressing Module

RUSRURussian Federation

Address Now Module
Enterprise Geocoding Module
Universal Addressing Module

RWARWRwanda

Address Now Module
Universal Addressing Module

BLMBLSaint Barthelemy

Address Now Module
Universal Addressing Module

SHESHSaint Helena, Ascension &
Tristan Da Cunha

Address Now Module
Universal Addressing Module

KNAKNSaint Kitts and Nevis

Address Now Module
Universal Addressing Module

LCALCSaint Lucia

Address Now Module
Universal Addressing Module

MAFMFSaint Martin (French Part)

Address Now Module
Universal Addressing Module

SPMPMSaint Pierre and Miquelon

Address Now Module
Universal Addressing Module

VCTVCSaint Vincent And The
Grenadines

Address Now Module
Universal Addressing Module

WSMWSSamoa

Address Now Module
Enterprise Geocoding Module 12

Universal Addressing Module

SMRSMSan Marino

Address Now Module
Universal Addressing Module

STPSTSao Tome And Principe

Address Now Module
Universal Addressing Module

SAUSASaudi Arabia

Address Now Module
Enterprise Geocoding Module
Universal Addressing Module

SENSNSenegal

Address Now Module
Universal Addressing Module

SRBRSSerbia

Address Now Module
Universal Addressing Module

SYCSCSeychelles

12 San Marino is covered by the Italy geocoder
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Supported ModulesISO 3116-1
Alpha-3

ISO 3116-1
Alpha-2

ISO Country Name (English)

Address Now Module
Universal Addressing Module

SLESLSierra Leone

Address Now Module
Enterprise Geocoding Module

SGPSGSingapore

Enterprise Routing Module
Universal Addressing Module

Universal Addressing ModuleSXMSXSint Maarten (Dutch Part)

Address Now Module
Enterprise Geocoding Module
Universal Addressing Module

SVKSKSlovakia

Address Now Module
Enterprise Geocoding Module
Universal Addressing Module

SVNSISlovenia

Address Now Module
Universal Addressing Module

SLBSBSolomon Islands

Address Now Module
Universal Addressing Module

SOMSOSomalia

Address Now Module
Enterprise Geocoding Module
Universal Addressing Module

ZAFZASouth Africa

Address Now Module
Enterprise Geocoding Module
Universal Addressing Module

SGSGSSouth Georgia And The South
Sandwich Islands

Address Now Module
Universal Addressing Module

SSDSSSouth Sudan

Address Now Module
Enterprise Geocoding Module

ESPESSpain

Enterprise Routing Module
Universal Addressing Module

Address Now Module
Universal Addressing Module

LKALKSri Lanka

Address Now Module
Universal Addressing Module

SDNSDSudan

Address Now Module
Universal Addressing Module

SURSRSuriname

Address Now Module
Universal Addressing Module

SJMSJSvalbard And Jan Mayen

Address Now Module
Enterprise Geocoding Module
Universal Addressing Module

SWZSZSwaziland
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Supported ModulesISO 3116-1
Alpha-3

ISO 3116-1
Alpha-2

ISO Country Name (English)

Address Now Module
Enterprise Geocoding Module

SWESESweden

Enterprise Routing Module
Universal Addressing Module

Address Now Module
Enterprise Geocoding Module

CHECHSwitzerland

Enterprise Routing Module
Universal Addressing Module

Address Now Module
Universal Addressing Module

SYRSYSyrian Arab Republic

Address Now Module
Universal Addressing Module

TWNTWTaiwan, Province of China

Address Now Module
Universal Addressing Module

TJKTJTajikistan

Address Now Module
Enterprise Geocoding Module
Universal Addressing Module

TZATZTanzania, United Republic Of

Address Now Module
Enterprise Geocoding Module

THATHThailand

Enterprise Routing Module
Universal Addressing Module

Address Now Module
Universal Addressing Module

TLSTLTimor-Leste

Address Now Module
Enterprise Geocoding Module
Universal Addressing Module

TGOTGTogo

Address Now Module
Universal Addressing Module

TKLTKTokelau

Address Now Module
Universal Addressing Module

TONTOTonga

Address Now Module
Universal Addressing Module

TTOTTTrinidad and Tobago

Address Now Module
Enterprise Geocoding Module
Universal Addressing Module

TUNTNTunisia

Address Now Module
Enterprise Geocoding Module
Universal Addressing Module

TURTRTurkey

Address Now Module
Universal Addressing Module

TKMTMTurkmenistan
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Supported ModulesISO 3116-1
Alpha-3

ISO 3116-1
Alpha-2

ISO Country Name (English)

Address Now Module
Universal Addressing Module

TCATCTurks And Caicos Islands

Address Now Module
Universal Addressing Module

TUVTVTuvalu

Address Now Module
Enterprise Geocoding Module
Universal Addressing Module

UGAUGUganda

Address Now Module
Enterprise Geocoding Module
Universal Addressing Module

UKRUAUkraine

Address Now Module
Universal Addressing Module

AREAEUnited Arab Emirates

Address Now Module
Enterprise Geocoding Module

GBRGBUnited Kingdom

Enterprise Routing Module
Universal Addressing Module

Address Now Module
Enterprise Geocoding Module

USAUSUnited States

Enterprise Routing Module
Universal Addressing Module

Address Now Module
Universal Addressing Module

UMIUMUnited States Minor Outlying
Islands

Address Now Module
Enterprise Geocoding Module
Universal Addressing Module

URYUYUruguay

Address Now Module
Universal Addressing Module

UZBUZUzbekistan

Address Now Module
Universal Addressing Module

VUTVUVanuatu

Address Now Module
Enterprise Geocoding Module
Universal Addressing Module

VENVEVenezuela, Bolivarian
Republic Of

Address Now Module
Universal Addressing Module

VNMVNViet Nam

Address Now Module
Universal Addressing Module

VGBVGVirgin Islands, British

Address Now Module
Universal Addressing Module

VIRVIVirgin Islands, U.S.

Address Now Module
Universal Addressing Module

WLFWFWallis and Futuna

123Administration Guide

Appendix A: Country ISO Codes and Module Support



Supported ModulesISO 3116-1
Alpha-3

ISO 3116-1
Alpha-2

ISO Country Name (English)

Address Now Module
Universal Addressing Module

ESHEHWestern Sahara

Address Now Module
Universal Addressing Module

YEMYEYemen

Address Now Module
Enterprise Geocoding Module
Universal Addressing Module

ZMBZMZambia

Address Now Module
Enterprise Geocoding Module
Universal Addressing Module

ZWEZWZimbabwe

Spectrum™ Technology Platform 9.0124

Country ISO Codes and Module Support



Notices



© 2013 Pitney Bowes Software Inc. All rights reserved. MapInfo and Group 1 Software are trademarks
of Pitney Bowes Software Inc. All other marks and trademarks are property of their respective holders.

USPS® Notices

Pitney Bowes Inc. holds a non-exclusive license to publish and sell ZIP + 4® databases on optical and
magnetic media. The following trademarks are owned by the United States Postal Service: CASS, CASS
Certified, DPV, eLOT, FASTforward, First-Class Mail, Intelligent Mail, LACSLink, NCOALink, PAVE,
PLANET Code, Postal Service, POSTNET, Post Office, RDI, SuiteLink , United States Postal Service,
Standard Mail, United States Post Office, USPS, ZIP Code, and ZIP + 4. This list is not exhaustive of
the trademarks belonging to the Postal Service.

Pitney Bowes Inc. is a non-exclusive licensee of USPS® for NCOALink® processing.

Prices for Pitney Bowes Software's products, options, and services are not established, controlled, or
approved by USPS® or United States Government. When utilizing RDI™ data to determine parcel-shipping
costs, the business decision on which parcel delivery company to use is not made by the USPS® or
United States Government.

Data Provider and Related Notices

Data Products contained on this media and used within Pitney Bowes Software applications are protected
by various trademarks and by one or more of the following copyrights:

© Copyright United States Postal Service. All rights reserved.

© 2013 TomTom. All rights reserved. TomTom and the TomTom logo are registered trademarks of
TomTom N.V.

© Copyright NAVTEQ. All rights reserved

Data © 2013 NAVTEQ North America, LLC

Fuente: INEGI (Instituto Nacional de Estadística y Geografía)

Based upon electronic data © National Land Survey Sweden.

© Copyright United States Census Bureau

© Copyright Nova Marketing Group, Inc.

Portions of this program are © Copyright 1993-2007 by Nova Marketing Group Inc. All Rights Reserved

© Copyright Canada Post Corporation

This CD-ROM contains data from a compilation in which Canada Post Corporation is the copyright owner.

© 2007 Claritas, Inc.

The Geocode Address World data set contains data licensed from the GeoNames Project
(www.geonames.org) provided under the Creative Commons Attribution License ("Attribution License")
located at http://creativecommons.org/licenses/by/3.0/legalcode. Your use of the GeoNames data
(described in the Spectrum™ Technology PlatformUser Manual) is governed by the terms of the Attribution
License, and any conflict between your agreement with Pitney Bowes Software, Inc. and the Attribution
License will be resolved in favor of the Attribution License solely as it relates to your use of the GeoNames
data.

ICU Notices

Copyright © 1995-2011 International Business Machines Corporation and others.

All rights reserved.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and
associated documentation files (the "Software"), to deal in the Software without restriction, including
without limitation the rights to use, copy, modify, merge, publish, distribute, and/or sell copies of the
Software, and to permit persons to whom the Software is furnished to do so, provided that the above

Spectrum™ Technology Platform 9.0126

http://www.geonames.org
http://creativecommons.org/licenses/by/3.0/legalcode


copyright notice(s) and this permission notice appear in all copies of the Software and that both the
above copyright notice(s) and this permission notice appear in supporting documentation.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THEWARRANTIES OF MERCHANTABILITY, FITNESS
FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD PARTY RIGHTS. IN NO
EVENT SHALL THE COPYRIGHT HOLDER OR HOLDERS INCLUDED IN THIS NOTICE BE LIABLE
FORANYCLAIM,ORANYSPECIAL INDIRECTORCONSEQUENTIALDAMAGES,ORANYDAMAGES
WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION
OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN
CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

Except as contained in this notice, the name of a copyright holder shall not be used in advertising or
otherwise to promote the sale, use or other dealings in this Software without prior written authorization
of the copyright holder.
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